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Introduction
About CADMOVER

Since the dawn of time, people have communicated with each other through
pictures. The first pictures were probably scratched on the ground with a finger or
a stick. In later days, cave painting reached a high art. Even in those days, it was
clearly evident that pictures held the ability to convey meaning, and people felt the
need to use them to express their thoughts and feelings.

When printing was invented, a single picture could be cut into a block of wood,
and then printed many times over. Cutting a picture into a block of wood is a
laborious process, requiring ample quantities of skill and patience. Our search for
better and faster ways to communicate graphical information continued.

Enter the Industrial Revolution. Photography. Offset printing. Wirephotos.
Photocopiers. Facsimile machines. The list of media used for the production,
storage, and transmission of pictures goes on and on.

Nowadays it isn't unusual for mechanical, architectural, and other engineering
drawings to reach a high level of detail and complexity without ever setting ink on
paper. Computers help us to make these drawings, more quickly and more
accurately than we ever could before.

The purpose of pictures is still the same: to communicate ideas. And in today's
global community, graphic communication is all the more important because,
although the human race has hundreds of different spoken languages, one picture
can convey meaning to everyone.

But —computers do not all speak the same language. A picture on one computer is
likely to be meaningless garbage on another computer. Even on the same
computer, different programs use different file formats, preventing graphics
programs from sending pictures to one another.

That's why Kandu Software is proud to present CADMOVER. Pictures
communicate ideas, and CADMOVER communicates pictures. It can read a
variety of CAD/CAM file formats, and rewrite a picture in another format. The
language barrier has been broken.

CADMOVER 4.0 User’s Manual
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Getting Started

Installing CADMOVER On A Hard Disk

There are several steps involved in installing CADMOVER® on your hard disk.

Make SURE that there are no anti-virus checkers running during the installation
process! This step is VERY IMPORTANT! Anti-virus software can damage
CADMOVER during its installation. After the installation is complete, anti-virus
software can be reactivated, and it will not interfere with CADMOVER's normal
operation.

If your computer has System 7 or above installed, you can temporarily disable
virus checkers by restarting your computer while holding down the SHIFT key.
Continue to hold down the shift key until you see the message “Welcome to
Macintosh / Extensions Off”.

If you are using System 6 or earlier, then it will be necessary to drag the icons of
any anti-virus software OUT of your System folder and then restart your computer.
After you restart, you may drag the icons for virus protectors back into your
System folder.

p lize Your Fl Dish
AFTER you have restarted your computer with virus protectors disabled, insert
your master floppy disk into the floppy drive, and double-click on the
CADMOVER icon to launch the application FROM THE FLOPPY DRIVE. The
personalization screen appears (Fig. 1-1). Replace the word “UNOWNED” with
your personalization (Fig. 1-2) information, preferably your name and
organization name, using at least 7 characters, but not more than 71. After a delay
of several seconds, the CADMOVER splash screen (Fig. 1-3) appears. When the
splash screen appears, choose Quit from the File Menu (or type command-Q).

CADMOVER 4.0 User’s Manual
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Enter your name or your company's name. Use at least
8 letters, but not more than ?1. The text you enter will
be displayed every time you start CADMODER®.

UNOLUNED

— —J|
Fig. 1-1: The Personalization Dialog After Clicking On The Word “Unowned”.

Enter your name or your company's name. Use at least
8 letters, but not more than ?71. The text you enter will
be displayed every time you start CADMOVER®.

Doug Woodstock -- Adirondack Software Co.

Fig. 1-2: A Completed Personalization Screen

CADMOVER® is
copyrighted © 1987-1993
by KANDU SOFTW ARE
CORPORATION. All rights
reserved.

Program written by
Ken Lathan.

00123456 Doug YWoodstock -- Adirondack Software Co.

Fig. 1-3: A Personalized Splash Screen.
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Run The Installer Application

The Installer application installs authorization to run CADMOVER on the hard
disk you choose. The Installer application MUST be run from the master floppy
disk, or it will not work properly. Detailed help for running the installer is
available by typing command-H once you have started the installer. The installer
application does NOT copy the CADMOVER application to your hard drive —
that's the next step.

C The Application To The Hard Dri
Drag the CADMOVER® icon from the floppy disk onto the same hard drive that
you selected in the Installer application.

*RESTART YOUR COMPUTER ONCE AGAIN

This is not a mandatory step, but if you have temporarily disabled your virus
protection, this is a good time to turn it back on by restarting your computer.

LY Master Disk In A Saf

Once CADMOVER has been installed on your hard disk, the original master disk
may be put away. You won't need it unless you wish to transfer authorization
from the disk where you've installed it to a different disk. Your master disk will
also be needed if you wish to reformat the hard disk where CADMOVER is
installed (see below).

Now you're ready to translate graphic files!

Important Note: Before You Reformat Your Hard Disk

If you should ever wish to reformat your hard disk for any reason, be SURE to
UNINSTALL CADMOVER (using the Installer application) before you reformat.
After you have completed the reformatting process, CADMOVER may be
reinstalled via the Installer application.

CADMOVER 4.0 User’s Manual
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Using CADMOVER

Using CADMOVER to translate files is a straightforward process. This chapter
constitutes a quick and easy primer for using CADMOVER. We have added a
Short Course section for those of you who are very conversant with the Macintosh.
All you have to do is select a file for input, and then select an output format and a
name for the translated file. CADMOVER does the rest.

Ihe Short Course - Open and Save

To translate a file, simply open the file you wish to translate, and wait until it has
been read in. Opening a file is accomplished by selecting “Open...” from the File
Menu. Then save the file by selecting “Save As...” from the File Menu. You may
change the output format by making a selection from the popup menu in the
“Save” Dialog before you click on the “Save” button. After clicking on the “Save”
button, the file will be saved in its new format.

Opening A File - The Details

Open... %0
Sapa #s... =S
{inse ®ii

Page Setup...
Print.., K%

Run Script... 3R

Quit %0

Fig. 1-4: The File Menu At Startup

When the program starts, the menu bar at the top of the screen will show the Apple
Menu followed by the words File, Edit and Options.

Move the cursor over the word “Open...”, and let go of the mouse button. Then
you will see a list of file names. You may look at file names on other disks by
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moving the cursor over the words Eject or Drive, and clicking the button once.
Clicking on the arrows at the right side of the list will move the list up and down.
Put the cursor on the name of the file you want, and double-click. The file will
open, and CADMOVER will read its contents.

The list of file names shows ALL the files in the current folder which CADMOVER
will be able to open. If you know that the file you want is in the current folder, but
it doesn't show up in CADMOVER's “Open...” list, then that file is NOT in a
format CADMOVER can read. See chapter 5, “File Formats” for a more complete
discussion of this topic.

While CADMOVER is busy reading and analyzing a file, it will display a book with
its pages turning. When the book disappears, and is replaced by the familiar
“arrow” cursor, CADMOVER is ready to save your file in a new format.

Once a file has been read, that file is the Active file. You can display it, copy it to
the Clipboard, or translate it to a new format. You can't open another file,
however, until the active file is closed. This fact will be reflected in the File Menu
itself.

pean... KR
Save fAs... %8S
Close W

Page Setup...
Print... 8P

Run Script... %R

Quit %0

Fig. 1-5: The File Menu After Reading A File

The above figure shows that when CADMOVER has an Active file, you can save it
or close it, but you can't open a second file at the same time. '

CADMOVER 4.0 User’s Manual
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Pasting A File Into CADMOVER

An alternate method of getting data into CADMOVER is to Paste it in from the
Clipboard. Data pasted from the Clipboard may be translated to any format by
selecting “Save As...” from the File Menu.

ile Int

In a likewise fashion, data may be gotten from CADMOVER by first opening a file
as above, but instead of selecting “Save As...” from the File Menu, select Copy
from the Edit Menu. The data will be placed on the Clipboard.

Saving a File

All you have to do to save a file is select “Save As...” from the File Menu (or type
command-$ ). The “Save As...” Dialog box will appear.

Active File: LINE.DHF
Input Format: DRF

Output Format: | 30GF |
<3 DHF ¥
£ BHOWN.DKRE Q e Ren
5 LINE.DKF
| 3 PLINE.DKE
| Desktop
O
I ) ( cancel )
Destination File Name: = ==
O A |

Fig. 1-6: The Save As Dialog

At the top of the “Save As...” Dialog box, the name and type of the active file will
appear. CADMOVER fills in the file name box with a suggested name for the
output file. The suggested name is a combination of the name of the input file and
a standard suffix taken from the currently selected output format. The suffix
changes whenever you select a different output file format. You can override the
suggested name with one of your own choosing, simply by typing over it.

CADMOVER 4.0 User’s Manual



16 Using Cadmover Chapter 1

Before you save a file, you may want to set up some translation options. Options
may be set at any time, except for the Units... and Scale... options, which cannot be
used before the file has been read.

3DGF
I — ARCHITRION 11
Active File: Adobe lllustrator™gg
Input Format: | C6M
DDES2
Output Format: | pIMENSIONS
DREAMS
|i Deskt D::‘l;us
F
= La0 GERBER PLOTTER ois

— Red Hots HPGL

[ BROWN.DKF | 1GES

[ BROWN.(6ES | MACDRAFT

{ | BRDUWN.DDES] MINICAD+ TEHT
MacRrchitrion TERT

e e e | PRET

Destination File PRESENTER PRO

[BROWN.EPSF PostScript

SCULPT 3D

STERECLITHOGRAPHY

SUPER 3D

WAVEFRONT

200M

&0

Fig. 1-7: Save As Dialog With ( An Edited ) Pop Up Menu.

lecti il r
The dialog box which appears in response to the “Save As...” command contains a

popup menu with an entry for each output format. To select the output format
simply choose a format from the menu.

Variations Within File Type

CADMOVER supports various versions of several different file types, notably PICT
and DXF. For these two formats, you can set up a preference that tells
CADMOVER what version of the format you want to write. The “PICT Output...”
and “DXF Details...” Dialogs (available from the main Preferences panel) have
controls to do just that. For PICT format, versions 1 and 2 are available; unless you
are running a Macintosh that does not have Color Quickdraw, in which case only
version 1 of PICT is available. For the DXF format, versions 9 through 12 are
available.
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After your version Preferences have been set, you can then save files in PICT or
DXF, and be sure of saving in the right version every time.

Adobe Qutput

For Adobe Illustrator output, various versions are available directly in the “Save
As...” Dialog.

Naming the Qutput File

CADMOVER automatically suggests a name for your output file, based on a
combination of the name of the input file, and the format you have selected for
output. This name can be changed to any name you like, but there are very few
reasons for doing so.

Eile Name Extensions

On various types of non-Macintosh computers, file types are identified solely on
the basis of the file name extension. (The extension portion of a filename begins
with the last or only period in the name, and continues through the end of the
name. For example, a file named “ABC.DXF” has an extension of “.DXF.” A file
name which does not contain a period is said to have no extension.) CADMOVER
will either add an extension if none is present, or modify the original extension, in a
manner consistent with the file's format. Especially for DXF and IGES files, it is
important to use the suggested extensions, because some programs will not read
those files unless this convention is followed.

If you don't want to use the name CADMOVER suggests for your output file,
simply type a new name in over the suggested one before clicking on the Save
button. That's all there is to it.

Closi Eil
Select Close from the File Menu, or just type command-llJ . The active file will be
closed, and CADMOVER will be ready to open another file.

If you are displaying a picture of the active file, and you close the window by
clicking in the close box at the upper left corner of the window, then only the
window will be closed. The active file is still open. You can still retrieve the
picture by selecting “Display Picture” from the Options Menu. CADMOVER has
been designed this way, so that for very large files, where redraw time may be
significant, you can use CADMOVER's options, system Desk Accessories, or switch
to other programs, without having to wait for the window to redraw.
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Pan and Zoom

When CADMOVER displays a
picture, the picture will be at
“Fit to Window” scaling. If the
drawing is already smaller
than the window, it will be
displayed at actual size.

Zoom In for Details

In order to examine detailed
areas of the file, CADMOVER
offers pan and zoom ability.
All you have to do, using a
mouse, is drag a rectangle
around the part of the picture
you want. When you release
the mouse button, the picture \

will zoom in. To return the \ > Pulling
window to the normal view, " 2B
simply hit the “=" (equals) key
on the keyboard.

Cable collar

Once a picture has been
zoomed in, the scroll bars
become active. You can use
the scroll bars to move the
picture around without
changing the scale. Again,
hitting the “=" key will return
the drawing to the normal “Fit
to Window” view.

This feature is solely for on-
screen inspection of the file,
and does not affect the
translation in any way.

Figs. 1-8: Pan And Zoom

CADMOVER 4.0 User’s Manual



Chapter 1 Using CADMOVER 19

Printing

The “Print...” option will be available after you have read in a file. CADMOVER
always scales printed images to fit on one 8 1/2" x 11" page, unless the actual size
of the graphic you are translating is smaller than one page, in which case it will
print at actual size.

Page Setup

The “Page Setup...” command is a standard item among Macintosh applications.
Depending on which printer you have chosen via the System's “Chooser” utility,
you will get a dialog box which lets you specify details about how you want the
printer set up. For example, you can use the “Page Setup...” command to say
whether you want to print in Portrait mode or in Landscape mode. If you choose
to print a document before you've used Page Setup, CADMOVER will
automatically bring up the Page Setup Dialog before the Print Dialog. But after
you've set up the page at least once, you may print as many documents as you like
without having to change the setup again.

You Only Get One Page
No matter how big your drawing or model is, CADMOVER always scales it to fit
on one page, just as it always scales drawings to fit on the screen.

High Precision
If you are printing to a LaserWriter, CADMOVER takes full advantage of the high
precision drawing available on that device.

ImageWriter Support

CADMOVER also takes full advantage of the abilities of the ImageWriter. If you
are running CADMOVER on a black and white machine, or if your color screen is
set to monochrome mode, then CADMOVER will express gray levels as patterns
on the ImageWriter, just as it does on a black and white screen.
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Canceling an Operation

In keeping with the Macintosh standard, the way to cancel any operation in
CADMOVER is to use the command-period keystroke combination (Command-.).
The action taken depends on what was happening in CADMOVER at the time you
hit command-period.

Reqdi Eil
When you cancel a translation while CADMOVER is reading a file, the current
input file will be closed, and CADMOVER will wait for a new “Open...”
command.

Wit Fil

When you cancel a translation while CADMOVER is writing a file, the current
translation will halt, and CADMOVER will wait for a new “Save As...” command.

rawin Pictur

Screen operations can be lengthy for large files. If you hit command-period while
CADMOVER is drawing to the screen, the drawing will halt and CADMOVER will
wait for your next command, whatever it may be. The current file will still be
open.
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The Options Menu

| Options I8

Units... %U
Scale... 8K

Two Sided Surfaces

Write Faces Only

Display Picture

Gray Background
vPICT 2

3D View

Show Log File

Choose Text Reader...

Choose Pict Reader...

Line Terminators...

Sound...

Preferences... 3,

Fig. 2-1: The Options Menu

The Options Menu lets you control the way CADMOVER will do its translations.
Many of the items on the Options Menu can also be found in the Preferences
Dialog; in these cases, the Preferences Dialog is used to control the default settings
of the items in the menu.

The options which have corresponding Preferences are:

* Two Sided Surfaces * Gray Background
« PICT1/PICT2 *  Write Faces Only
* Show Log File » Display Picture

Any options set via the Options Menu take effect immediately.
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Units...

When CADMOVER starts up, this option is dimmed. It's necessary to read in a file
before the “Units...” Dialog can be used. But, once there is an active file, the Units
control gives you the power to control the usage of measurement units for the

translation.
Using the “Units...” Dialog, you can:

«  Convert from one measurement unit to another

«  Convert between English system and Metric system

*  Specify your own measurement units

»  Override the units specification in an input file

«  Override CADMOVER's assumptions about unspecified units

When you select “Units...” from the Options Menu, you'll see this dialog box:

The input file is in Inches. Click on any
button to select new units.

O override Input Units

@® Inches O Meters

O Feet O Centimeters
O Miles O Millimeters
O Mils O Kilometers
(O Microinches O Microns

O User Defined

/SEEEE—
LK ]
v

Fig. 2-2: The Units Dialog Box

c i B t Unit
The selected radio button will agree with the text, to show you what units have
been specified for the input file. To change to a different unit when writing the
output file, all you have to do is click on the appropriate radio button, and then
click OK. CADMOVER will apply the correct scale factor.
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The size of the drawing or model will remain the same (unless you change it with
the “Scale...” Dialog). The numerical content of all coordinates will change to
reflect the usage of the new unit system.

As an example, if you have a file which contains a line exactly one inch in length,
and you specify conversion to Centimeters, the output file will contain a line 2.54
cm long (1 inch = 2.54 cm).

tw lish nd M i

No special controls are required. The general layout of the Units Dialog is such
that units within the English system are shown in the left column, and Metric units
are shown in the right column. The notable exception is the button for User
Defined units, which is explained below.

Specifying Your Own Megsurement Units

Click on the User Defined button to tell CADMOVER about your own
measurement units. The button will be highlighted, and the Custom Units Dialog
will appear.

veriding the Unit Specification n an Input Fil

Click in the check box marked “Override Input Units”. Now, instead of converting
from the input units to your choice of output units, CADMOVER will actually
consider that the input file contains the units you've specified.

As an example, if you have a file which contains a line exactly one inch in length,
and you use the Units Dialog to specify Centimeters, and you turn on the Override
control, then the output file will contain a line one centimeter long.

verridin : mpti t
This is done in exactly the same way you would override the units specification in
an input file. Just check the box marked “Override Input Units”. This ability can
be particularly useful if you want to translate a DXF file which has been written
using units not available in the “DXF Units” control on the Preferences Dialog.
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Custom Units

Name of Custom Unit ﬁnches J

Measurement System
O Metric @ English

units per inch Il

inches per unit

Fig. 2-3: The Custom Units Dialog Box

Using the Cust Units Dial
There are three items to specify: (1) the NAME of your custom measurement unit,

(2) whether it relates to the English system or the Metric system, and (3) how your
custom unit is related to either inches or centimeters.

Select the unit system associated with your custom units. If you click on the Metric
button, the messages which read:

inches per unit

units perinch
+ will be changed to read

cm per unit

units per cm.

You may type into either of the two numeric boxes. This makes it easier to work in
units which may be much bigger or much smaller than an inch or a centimeter.
The other box will show the inverse of the number you enter.

The picture, on the next page, illustrates the Custom Units Dialog as it might have

been used by an engineer in the employ of the Pharaoh Cheops, in the days when
pyramids were a new thing.
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Custom Units

Name of Custom Unit |Cubits

1 Measurement System
O Metric @ English

" units per inch 4

inches per unit 0.25

/V ) -m
AN - S/
Y —

—
=

Fig. 2-4: The Custom Units Dialog Showing 4 Cubits Per Inch

Scale...

The Scale Dialog can give you very fine tuned control over the final size of the
drawing being translated. The text at the top of the window shows you how big
the drawing is to begin with. You can give it a new size in one of five ways:

Specify a new width, or
Specify a new height, or
Specify a new depth, or
Specify a reduction factor, or
Specify an enlargement factor.

The Aspect Ratio of the drawing is always maintained. Whenever you change one
of the five parameters, CADMOVER changes the other four to stay in step with the
new size you've specified. As an example, suppose you read in a DXF file which
contains a drawing 6 inches high and 7.45 inches wide. You want to place the
picture into a page layout program, where there is a space exactly 3 inches wide for
the picture. There's no need to do complicated scale factor calculations. Just type a
“3” into the “Width” box, and click OK. Then Save the file. The picture in the
saved file will be exactly 3 inches wide.

e o ° o o
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t Height or Widt

Using the same basic method, you can scale a picture to the exact height you need
(instead of exact width). Or, if you need to know the reduction factor or
enlargement factor, you can enter it directly.

Combination Method of Scaling

Using a combination of methods often achieves the goal of having a precise scale
factor and a good fit, with a minimum of difficulty. First, enter the maximum
allowable height or width for the output drawing. CADMOVER will fill in a new
value for the scale factor. Then, simply round the scale factor up to the nearest
acceptable value. The height, width, and depth will be reduced slightly, and you
will have a drawing which will fit into the intended destination area, and has a
known, exact scale factor.

This model is 608.19156 by 405.76253 by 0
Inches.
H Axis (Width) 608.19156 l
¥ Axis (Height) 405.76253
Z Axis (Depth) 0
Reduction Factor 1
Enlargement Factor 1

o

Fig. 2-5: The Scale Dialog

Figure 2-5 above shows a sample of the Scale Dialog. You may enter new values
into any of the number boxes. No matter which of the five values you change, the
other four will be automatically recomputed to preserve the original aspect ratio.

If any of the HEIGHT, WIDTH, or DEPTH values are ZERO, you will not be able to
change that value, since that would make it mathematically impossible to preserve
the aspect ratio.
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This model is 608.19156 by 405.76253 by 0

Inches.
H Axis (Width) 304.09578
¥ Axis (Height) 202.88126
2 Axis (Depth) 0
| Reduction Factor 2
Enlargement Factor 0.5
([ ok ]

Fig. 2-6: The Scale Dialog Showing A 2:1 Reduction

Figure 2-6 shows the same “Scale...” Dialog, but this time with a reduction factor
of 2 to 1 entered. Note that the height and width are half of their previous values.

1 ti lin tions for For

The scale factor set by the “Scale...” Dialog also applies to pictures copied to the
Clipboard. Particularly when you intend to Copy to the Clipboard, or when you
are saving a PICT file, it is important to be aware of the scale factor. It is not
uncommon for files which have been created in real-world scale to be too large to
represented in PICT. CADMOVER will automatically reduce such files before
saving them in PICT format, and the new scale factor will be chronicled in the Log
file. But results will usually be better if you set the scale yourself.

Two Sided Surfaces

You will usually want to turn this option ON when you are translating into a 3D
format which considers surfaces to be one-sided. Super 3D and Zoom fall into this
category. IGES, DXF, SCULPT 3D & 4D, and ENVISAGE 3D do not. CADMOVER
will generate, for each input surface, two surfaces in the output file, facing in
opposite directions. This makes the output file much larger, but makes it possible
to do quality rendering after you've read the file to your target program. For more
details see page 51 in the Preferences chapter.
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Write Faces Only

This option, like the one above, is designed primarily for 3D output. It causes
CADMOVER to filter objects as they are written, and it will not write out any object
which is not a surface entity. It is especially useful for translating 3D DXF and
Dimensions files into Super 3D.

Display Picture

The Display Picture option allows the user to control whether a picture of the input
file will be displayed. When the option is OFF, CADMOVER will process files
without displaying them. This can be a useful timesaver if you have a lot of files to
translate, or if your files are very large. Also, if the picture window gets overlaid, it
will try to redraw itself. Turning the picture OFF will avoid the redraw.

On the other hand, if you want to see the picture, turn this option ON. Closing the
picture window by clicking in its close box turns off the Display Picture option in
the menu. Turning the option back on will allow the picture to be redisplayed.

Gray Background

Some files read by CADMOVER contain pastel or white lines. To make it possible
to see the graphics in this type of file, choose Gray Background from the Option
Menu. When this option is turned on, CADMOVER will display the drawing on a
gray rather then white background. The background will not be included in the
output file.

CADMOVER uses a gray pattern to produce the gray background if your computer
doesn't support multiple grayscale levels, or if you are running in black-and-white
mode. When multiple levels of grayscale are enabled, CADMOVER takes
advantage of the hardware, and uses a solid gray color as a background.

PICT1/PICT2

CADMOVER imports as well as exports PICT files. The program does not
distinguish between PICT1 and PICT2 when reading PICT files. CADMOVER
will write PICT2 if you are running on a machine which supports color
QuickDraw™, and PICT1 otherwise.

Many programs on the Macintosh are completely insensitive to variations between
PICT1 and PICT2. A few programs on the Macintosh do make a distinction,
usually in the way colors are handled. If you are using a program which gives
different results depending on the PICT version used, make note of which version
serves you better and set CADMOVER's Preferences accordingly. Various
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programs on computers other than the Macintosh can read PICT files produced on
the Macintosh. Most of these do not process PICT2 correctly, so PICT1 will
probably be a better choice for you if you plan to take your PICT files to a different
make of computer.

Once the type of PICT is selected then go to the “Save” Dialog and click on the
PICT button.

3D View...

You can select any view of a 3D model for export to a 2D program by using the 3D
View Option.

Enter absolute rotation values in degrees

HAHIS |0
Y AHIS |0
Z ARIS (O

)

Fig. 2-7: The 3D View Dialog

Open a 3D file. After the file has been read, go to the Option Menu and select 3D
View. A rotation dialog allows entry of X, Y, Z coordinates for angle of display of
the 3D model. Enter the rotation angles. CADMOVER then displays the rotated
view. The displayed view of the 3D model will be used for 2D export.

The X axis is the horizontal axis, Y is the vertical axis, Z is the depth. Enter angles
in degrees. To change the view, choose “3D View...” from the Option Menu
again, and continue as above.

Advanced 3D View Option

The 3D View Dialog gives you the ability to rotate 3D models to any point of view
by entering rotation values for the X, Y and Z axes, in that order. Although this
does make it possible to view your model from any angle, it is sometimes difficult
to find the exact values that will produce the rotation that you want.
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Beginning with version 4.0, CADMOVER now offers a more comprehensive way to
specify rotation angles. It is now possible to enter rotation values in any order, and
more than one value can be entered for any given axis.

For example, if you are looking at a 3D object from the top, and you want to get an
orthographic projection, the most straightforward way to do it is first to rotate the
object 270° around the X axis to produce a side view, then rotate around the Y axis
by 45° so that two sides of the object are visible, and then rotate AGAIN around the
X axis, between 30° and 45°, to lean the near corner of the object downward and
provide a view of the top. In order to specify this rotation, type “270x45y30x” into
the “X Axis” field of the 3D View Dialog. When you use this method, the other
two fields (“Y Axis” and “Z Axis”) will be ignored.

— — —- —
e e

e — —_—

Enter absolute rotation values in degrees

HAHIS [270845Yy30H
Y AXIS |0
Z AHIS (O

Lok

Fig. 2-8: The 3D Rotations Dialog With Advanced Rotation Input
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When using this method, the various rotations will be applied in the order they are
specified. This ability makes it MUCH easier to find any particular vantage point.

Rotati |
The following example may help to illustrate the difference that changing the order
of rotations can make. First, let's start with three views of a rather crudely
constructed car:

(11

90° around Y axis

-——s s ——

= =

No Rotation 90° around X axis

Now, here's the same car, rotated first 30° around the X axis, and then 45° around
the Y axis:
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The next view uses the same rotation angles, but applies them in a different order,
namely, first 45° around the Y axis, and then 30° around the X axis:

Show Log File

CADMOVER can create a log file which chronicles the translation of each file you
open. The Show Log File option controls whether you see the log file as it is being
written. Regardless of whether you choose to view the log file, the Keep Log File
preference (on the Preferences... Dialog) determines whether the log file will be
saved to disk.

CADMOVER creates a new log file for each input file you open, so long as either
Show Log File or Keep Log File are set ON.

The Log File window displays a continuous stream of messages. The window does
not close itself between files.
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Log File Messages

CADMOVER 3.5 TRANSLATION LOG

INPUT FILE NAME IS 'Kandu.1'

INPUT FILE TYPE IS EPSF

INPUT FILE SIZE IS 257418 BYTES
TRANSLATION BEGINNING 940104.143454

aa

The messages range from the simply informative (e.g. a time/ date stamp which
chronicles the processing of each file), to warning or error messages. WARNING
messages inform you of unusual conditions; no error is indicated. ERROR
messages relate to actual problems within the input file. CADMOVER may or may
not be able to continue processing if an error condition is encountered.

Choose Text Reader...

Many of the files written by CADMOVER are text files. IGES and DXEF files are
both text based, and the Log files produced by CADMOVER are also text files. If
you want to read these files, or print them, then you must use a text processing
program. The Choose Text Reader option gives you the opportunity to inform
CADMOVER what your preferred program is. Almost all text processing
programs can open any text file, but when you double-click on a file icon in a
Finder window, the Finder uses information in that file to decide which program
you want. The Choose Text Reader option sets that information.

Choose PICT Reader...

This command is very much like the command above, except that it affects the
PICT files CADMOVER writes. When you issue this command, a standard “Open
Flle” type of dialog is displayed. The list in the dialog window shows only folders
and programs. Choose the program which you would like to automatically launch
when you double-click on the icon of a PICT file written by CADMOVER.

Line Terminators...

The line terminator option gives you the power to determine in advance the most
likely destination of files written by CADMOVER. Many of the output formats,
particularly IGES and DXF, can be formatted as they are being written to conform
to the norms for Text files on the systems where the files will actually be used.
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Macintoshes, MS-DOS computers, and most UNIX machines each have their own
separate standards for Text files. There is even a fourth configuration for IGES
files: fixed blocked records.

If you use CADMOVER's Line Terminator option, you can relieve yourself of the
necessity of doing “system conversion” on the files before using them on other
computers.

Please indicate the kind of
computer system where the
translated file will be used.

O Macintosh

I OEnport to UNIR

@® Export to MS-DOS

O Export to MAINFRAME

[J Save Settings

" r_—m ——Cancel

Fig. 2-9: The Line Terminators Dialog

Sound...

The “Sound...” control is a tool you can use to customize CADMOVER's choices of
when to beep. Because translations can sometimes take more than a few minutes,
and it's not always clearly evident when a translation is complete (especially when
CADMOVER is running in the background), you have the option of having
CADMOVER beep when an operation is complete.

An optional beep can be specified separately for when (1) a file has been
completely read in, and (2) when a file has been completely written out. In
addition, you may separately specify one set of beeper options for interactive
mode, and a different set of beeper options for batch mode. In all cases, the “beep”
referred to here is whatever sound you have chosen in your system to be the
standard beep sound.
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Preferences...

See Chapter 4 for complete information on the Preferences Dialog.

FontMap...

When translating PICT files into DXF format, CADMOVER keeps track of font
information, so that different fonts may be distinguished from each other by the
receiving system.

User Control

The selection of which font is used by the receiving system is under your control.
If you are using AutoCAD to read the DXF files produced by CADMOVER, all the
type faces will appear the same when AutoCAD first displays the drawing. To
assign a different type face to a text string, first use the “List” command in
AutoCAD to find out what the “Style” of the text is. Then issue the “Style”
command, and type in the style name that was shown by the “List” command.
AutoCAD will then ask you to select a font file for that style. Select an existing font
file. After that, there will be a number of prompts having to do with details of the
type style. You can just hit the carriage return for all of these prompts. After the
last prompt, the screen will refresh, and you will see that all of the text in the style
you have been working on displayed with its new text face.

Why Can't Cad Assign The Font Files?
For two reasons. First and foremost, there's no guarantee that the receiving system
will have any particular AutoCAD font file on it. And if AutoCAD tries to read a
DXF file which names a font file that's not on your system, it will issue an error
message and discard your drawing. The second reason is to provide the maximum
amount of user control over the relationship between Macintosh fonts and
AutoCAD fonts. There are no clear guidelines, and since different users have
different needs, it is up to each user to determine which AutoCAD font is the best
match for each Macintosh font used.

Eormats With Font Information

The formats that contain font information (other than Macintosh-native formats)
are CGM, DXF, HPGL, and IGES. CADMOVER will enable the Font Mapping
Menu selection after you have read in a file in one of these formats.
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tyl , Font

DXF files contain text styles, which in turn refer to fonts, CGM HPGL, and IGES
contain font codes. For the purposes of font mapping, CADMOVER treats DXF
styles the same way it treats font codes in CGM, HPGL, and IGES. So at least for
the purpose of this discussion, no further distinction is made between fonts and

styles.

Importing To Macintosh

When you use CADMOVER to translate foreign files into many of the formats
which are native to the Macintosh (e.g. PICT format), you can describe a mapping
from their fonts into Macintosh fonts, by using the FontMap Dialog.

How To Get The Dialog

The FontMap Dialog is only available when there is a file open, whose format is
CGM, DXF, HPGL, or IGES. Find the “FontMap...” entry in the Options Menu. If
you don't see that item on the menu, there is no font information to be mapped.

How It Works

The dialog contains two popup menus. The menu on the left shows you the text
styles which are defined in the input file. The menu on the right shows you the
fonts which are currently available on your Macintosh.

First, select a font from the left hand menu. The right hand menu indicates the
Macintosh font which will be used to represent that style. Normally, CADMOVER
assumes that all foreign fonts will map into a Courier font. If your Macintosh
doesn't have Courier installed, CADMOVER will assume that it should use a
Monaco font, which is always present. These fonts are chosen because they are
both monospaced fonts, i.e., each letter in the font takes up the same amount of
space in the line,

Next, select an entry from the right hand menu. The Macintosh font you select will
be associated with the input font which is currently showing in the left hand menu.
Then click the OK button. If the picture window is open, the graphic will be
redrawn with the new font information.

You Decide

Since there are no guarantees that any particular Macintosh will have installed
fonts which resemble the fonts in any given foreign file, it's up to you to assign
fonts which provide a good match to the original styles. In any case, Courier is a
good general match, and CADMOVER will do a good job of matching the font size
regardless of which fonts you have chosen.
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INPUT FONT [ STANDARD | FONT | Courier |

For each INPUT FONT in the left menu, select
a Macintosh font from the right menu.

Fig. 2-10: Above Shows The FontMap Dialog As It Initially Appears.

Figure 2-10 above shows the FontMap Dialog as it initially appears. The left hand
menu selects the input text style being converted, and the right hand menu
shows the Macintosh text font that the style will be converted into.

STANDARD
USER1
USER2
v USER3 ] FONT [_Courier ]
USER4

For each INPUT FONT in the left menu, select
a Macintosh font from the right menu.

Cancel

Fig. 2-11: The FontMap Dialog Showing A List Of Input Text Styles.
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On the previous page, Figure 2-11 shows the same dialog with the left hand menu
popped up. The exact contents of the menu will depend on the file being
converted.

Chicago
Courier
Geneva
Helvetica
INPUT FONT [_STANDARD ] vMonaco  |]
New York
For each INPUT FONT in the left me ;’;:;‘s'““
a Macintosh font from the right m

P —

Fig. 2-12: Shows The Dialog With The Right Hand Menu Popped Up.
Above, Figure 2-12 shows the dialog with the right hand menu popped up. The

exact contents of the menu will be determined by what fonts are installed on your
Macintosh.
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The Lines Menu

The Lines Menu does not always appear; its presence is dependent on the contents
of the file you are translating. But when it does appear, it is there to offer you a
way to control the mapping of dashed line patterns into MiniCad+.

User Defined Dashes

A number of exchange formats, including IGES and DXF, support the notion of
user defined line dashes. When user defined dashes are found in an input file,
CADMOVER creates the Lines Menu, with one entry for each different dash style.

User defined dashes can express any combination of dashes and spaces. Each
individual dash segment can be any length, and the spaces between dashes can
also be any length. A dash style can contain any number of line segments and
spaces.

CADMOVER can map user defined line styles into the predefined set of styles
offered by MiniCad+. But since the number of possible user defined styles is
effectively infinite, the onus falls on the user to tell CADMOVER which user
defined styles correspond to which predefined styles. That's the purpose of the
Lines Menu.

he Lin n

When the Lines Menu is present, it shows all the user defined dashing styles
contained in the input file. Select a line style to map over, and the Line Mapping
Dialog window will appear. Use the dialog window to associate a predefined line
style with the style you have chosen.
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Fig. 3-1: Sample Lines Menu

When the Line Mapping Dialog (Fig. 3-2) first appears, it will show the name of
the selected line style (if there is a name), and a sample of that line style, which
should look identical to the style selected from the Lines Menu, except that it is
drawn in a bolder stroke. The line that runs across the lower half of the dialog
window shows you the currently selected output line style. In general, if no
mapping has been specified, then CADMOVER will produce a solid line (no
dashes).

All you have to do is select a target line style from the popup menu entitled “MAP
TO:”. When the popup menu appears, it will show you what predefined styles in
MiniCad+ are available . When you let go of the mouse button, the mapping will
be established to the style you've chosen.

LTYPEOG

] Minicad+

Fig. 3-2: The Line Mapping Dialog As It First Appears
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LTYPEOG

MiniCad+

Fig. 3-3: The Line Mapping Dialog With Its Popup Menu Up.

LTYPEDG

MAP T0: [_. ----------- TJ MiniCad+

Fig. 3-4: The Line Mapping Dialog After Making A Selection

Figure 3-3 shows the Line Mapping Dialog with the popup menu visible, and a
new choice selected. Then, Figure 3-4 shows that the line drawn across the lower
half of the dialog window now corresponds to the entry selected from the popup
menu.

Lines in the input file which are dashed according to the user defined style

“LTYPE06” will be translated to MiniCad+ as the lower line in the dialog box
(Figure 3-4) shows.
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Figure 3-4 shows the predefined Line Style Selection Menu for MiniCad+. The
selection is made based on the visual appearance of the dashes. The input style
(the heavy line across the top) appears to be most closely matched by the sixth
MiniCad+ line style (shown highlighted). When the mouse button is released, the
connection is established.

If you click the OK button to accept the mapping, and then subsequently select the

same line style from the Lines Menu, the lower heavy line will still show the sixth
MiniCad+ style, indicating that a line style mapping has been established.
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The Preferences Dialog

The Preferences Dialog gives you the ability to set many of the options available in
CADMOVER to your customized configuration. The dialog box is pictured below:

CADMOUER Preferences

[J] Show LOG File [X Display Picture []Two Sided Surfaces
[0 Keep LOG File [] 6ray Bkgnd. [] Write Faces Only

Number of Spline Segments (12

PICT Output... ] [ Placement... ]

( CGM Details... |
)

(Gerber Plotter... IGES Details... ] ( Maxima... |

( EPSF Output...

( EPSF Input... Tesselation... | [ Spline Mesh... |

(
(
( DHF Details... | [ Background... )
(
(

HPGL Details... |

Fig. 4-1: The Preferences Dialog

The standard Preferences are shown. Use the various controls to customize
CADMOVER for your own translation needs. Values you set using this dialog box
will be used each time you run CADMOVER. The button controls present more
detailed dialogs for each area of interest.
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Show Log File

When this preference is checked, CADMOVER will display its Log File data for
each file you translate. The Log File shows the time and date of each translation,
and the name and type of every file read in and every file written out. Also,
warning messages and error messages are displayed in the Log File window. The
Log File will be saved to disk if the “Keep Log File” preference is checked (see
below).

Keep Log File

When this preference is checked, CADMOVER will save a copy of its Log File data
for each file you translate. (See the preceding paragraph.) The name of the log file
will be made from the name of the input file, with “.Log” appended to the end. So,
for example, if you read a file named “DRAWING6.IGS”, its associated Log File
will be named “DRAWINGS6.IGS.Log".

Display Picture

The Display Picture preference tells CADMOVER whether you want it to show a
picture of each file you open. The initial setting of the “Display Picture” item in the
Options Menu is taken from this check box. If you are working with a lot of files,
or with very large files, the time taken to draw each file may be significant. So
CADMOVER provides you with this control as a time saving device.

Gray Background

This preference controls the default setting of the Gray Background entry of the
Options Menu. When it is turned ON, CADMOVER will use a gray color (or gray
pattern on black and white screens) so that graphics drawn in a white color may be
seen.

Write Faces Only

This preference corresponds to the item of the same name on the Options Menu.
When it is turned on, CADMOVER will only write surface objects to the output file.
Other data types, such as lines and curves, will not be written. This option is
primarily intended to be used when translating Dimensions or Presenter
Professional files into Super 3D format. It results in a cleaner looking model.
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Two Sided Surfaces

This preference controls the way CADMOVER writes some 3D file formats. Many
3D programs treat surfaces as two-sided, i.e., no matter which side of the surface
you are looking at, it is visible. Other 3D programs consider surfaces to have a
distinct “front” and “back” side. Surfaces seen from the front are visible, but
become invisible when they are turned around.

When the Two Sided Surfaces preference is turned on, CADMOVER will generate
two surfaces, facing in opposite directions, for each surface in the input file. This
can make the output file much larger, but the benefit is that you will get a much
better representation of your 3D model.

Figures 4-2 and 4-3
show a 3D model,
drawn in AutoCAD
and saved in DXF
format, taken to Super
3D.

The first picture shows

the results obtained

when the Two Sided \

Surfaces option is NOT : . sl
Fig. 4-2: Two Sided Surfaces Turned Off

used. Many of the
surfaces appear to be
missing.

The second picture
shows the same model,
this time translated
with the Two Sided
Surface option turned
ON.

Fig. 4-3: Two Sided Surfaces Turned On
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Number of Spline Segments

This field controls the interpolation of parametric cubic and Bézier spline curves.
The number represents how many straight line segments will be used to represent
a single spline segment. The value 12 is a good general-purpose choice which will
result in fairly smooth curves without using excessive amounts of storage or
computation time. For small graphics or very gentle curves, a lower value such as
6 or 8 may be appropriate. For tight curves or very large graphics, numbers as high
as 24, or even 32, may work better for you. Numbers higher than 32 generally do
not improve the appearance of spline curves, and in fact may even degrade
appearance.

CGM Details

CGM files are subject to wide variation in the ways that they are constructed. This
is particularly true for the scale of the imported picture. Often CGM files have no
particular scale at all associated with them; they are considered to be displayed
correctly so long as their aspect ratio remains unchanged. This condition is known
as abstract scaling.

CGM Details

Please describe a method for CRDMOUER® to
determine picture size information from CGM
files specified in ABSTRACT mode.

Data Sizing Technique: Relate UDC units to:
@ Use UDC ERTENTS ® Inches

O Use Geometry in File Millimeters

VDC UNITS per inch [72 |

o

o< )

Fig. 4-4: The CGM Details Dialog
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CGM Scaling on Input

Another variable in CGM files is the presence or absence of a “VDC Extents”
descriptor. If such a descriptor is present in the file, it can be used to describe the
scale of the picture.

CADMOVER offers several ways to control picture scaling on input. You can elect
to use the VDC Extents, or ignore the extents and use the geometry in the file. If
you do choose to use the VDC Extents, and a descriptor is present in the file,
CADMOVER will determine the size of the picture from the VDC Units Per Inch
(or VDC Units Per Millimeter) constant which you provide to the CGM Details
Dialog,.

If CADMOVER cannot determine an absolute scale for the file, it will generally
default to a very large scale, in order to preserve the greatest amount of drawing
accuracy. In such cases, you will probably want to use CADMOVER's “Scale...”
Dialog to control the size of the output file.
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Gerber Plotter Details...

The Gerber Plotter Preferences Dialog controls the way CADMOVER interprets
Gerber Plotter files. CADMOVER will read both Pen Plotter and Photo Plotter
files. Before you open any GERBER file for input, you must first be aware of
whether the file is in Absolute or Incremental mode. CADMOVER gives you the
ability to specify either English or Metric units, and the units per inch (or units per
millimeter) can also be specified, giving you total control over drawing scale and
accuracy.

Gerber Plotter Input

@ Absolute ( Apertures... ]
| [O Incremental ( Pens.. |

@ English O Continuous
O Metric @® Asymmetric

Fig. 4-5: Gerber Plotter Details Dialog

You can also specify Pen Weights for pen plotter files, and aperture sizes for photo
plotter files. CADMOVER's interface allows you to specify the relationship
between aperture numbers and D-codes.

Absolute or Incremental

Gerber files may be either in Absolute or Incremental mode. In absolute mode, the
file contains actual coordinates describing the exact location where the pen or
aperture is to be moved. In Incremental files (sometimes known as Relative files),
the coordinates specify how far the pen or aperture is to move from its previous
position. Therefore, each line is relative to the previous one.
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CADMOVER accepts both kinds of files. The files themselves don't contain any
information that can identify whether the file is absolute or relative. It's up to you
to have the right settings in place when you read the file. It's pretty obvious when
the wrong choice has been made — you'll get a picture that bears some
resemblance to the aftermath of an explosion in a coat hanger factory. If that
happens, just choose the other setting, close the file, and open it again.

Normally, files from the same source will always be absolute, or they will always
be incremental. So long as you are translating Gerber files from the same source,
you should not have to change this setting again.

Enalist Metii
The coordinates in Gerber files can be specified either in English units (i.e., inches,)
or Metric units (centimeters.) When you click on either one of these radio buttons,
a second dialog will pop up, asking you how many plotter units make up one inch
(or centimeter). 1000 plotter units to the inch is a typical value.

Please enter the number of
plotter units per inch.

(1000 |

Fig. 4-6: Plotter Units Per Inch.

The appropriate Plotter Units Dialog will appear whenever you click on either the
English or Metric radio button, even if that is the button that is already selected.
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Continuous Qr Asymmetric Line Control
These buttons control the way lines are treated as they are read in from a Gerber
file.

Continuous

With “Continuous” selected, CADMOVER will build up polylines from the line
strokes in the file. So long as a new line begins exactly at the point where the
previous line left off, CADMOVER will be able to connect those segments into a
single polyline construct. What is sacrificed in order to be able to do this is the
exact aperture shapes specified for each segment. CADMOVER will assume a
square aperture for polylines, since most CAD file formats do not allow different
pen shapes for segments within the same polyline.

Asymmetric

When you select “ Asymmetric,” CADMOVER makes no attempt to connect
segments. But all horizontal lines will be translated with a pen width consistent
with the vertical extent of the specified aperture. Vertical lines will be translated
with a pen width consistent with the horizontal extent of the specified aperture.
And, diagonal lines will use the average between the horizontal and vertical
extents as a pen width.

Set up aperture descriptions

Aperture Number

il

D-Code

Aperture Shape | Square |
Height [10 [
Width [10 |

(Nent J( Prev ] [ New ][ Delete
| (Canc@ ( Get... ] (Store...)

Fig. 4-7: The Apertures Dialog
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Apertures...
Overview

Click on the “Apertures...” button to get the Apertures Dialog.(previous page).
CADMOVER offers an unlimited number of apertures. For each aperture, you may
set the associated D-code, the aperture shape, and its horizontal and vertical size.
The shapes available are Square, Circle, Rectangle, and Ellipse. Of course, for
Square and Circle apertures, the horizontal and vertical size must be identical. This
is reflected in the fact that so long as either Square or Circle are selected via the
popup menu, anything you type into the “Height” box will also appear in the
“Width” box, and vice versa. For Ellipse and Rectangle aperture shapes, the height
and width may be set independently.

Apertures are numbered sequentially, starting at 1. You may add new apertures
by clicking on the “New” button. CADMOVER will suggest an appropriate D-
Code for the new aperture. You may change it to any value you prefer, but please
be careful. CADMOVER performs no validity checking of any kind on the
aperture information you give it. Results are undefined if you create an aperture
list with the same D-Code appearing more than once in the list.

The “New” button creates a new aperture at the END of the list. The new aperture
being created will have the same particulars as the highest-numbered aperture at
the time you hit the “New” button.

rt Note: Previ | t Apetur

The “Delete” button deletes the current aperture and all higher-numbered
apertures in the list. USE IT WITH CAUTION!

The “Get...” and “Store...” buttons provide a way to save and use many different
sets of aperture configurations. It is likely that you may want to have a given
aperture configuration in use to translate all files from one provider, and a different
set of apertures for files from a different provider. That's where these buttons come
in.

Clicking on the “Store...” button brings up a standard “Save As...” Dialog, letting
you choose where your aperture Preferences are to be stored, and giving you the
option to give a file name to your aperture file.

Conversely, once a set of aperture Preferences has been stored, you can click on the
“Get...” button to get it back. When you click on the “Get...” button, a standard
“Open..."” Dialog appears. The dialog will list only folders and aperture preference
files. Once you have selected an aperture file, click “OK”, and the sorted aperture
list will be read in.
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(T li

There is even a separate application, “AperText”, that converts properly formatted
text files into CADMOVER aperture lists. AperText is documented in Chapter 7.

iti
When you are using CADMOVER to generate Gerber Plotter files, CADMOVER
will automatically build an aperture list, in text format, suitable for retranslation by
AperText.

Drag & Drop

You can launch CADMOVER (under system 7) by dropping one or more document
icons on the CADMOVER application icon. If one and only one of these icons is a
GERBER Aperture Preference file, CADMOVER will automatically start up, using
the apertures described in that file.

To do the equivalent action under System 6, highlight one or more documents and
the CADMOVER icon. (All of the icons, including CADMOVER, must be in the
same folder.) Then double-click on the CADMOVER icon, or type command-O.

iting Filled R nal

When translating files made by applications which support an actual “rectangle”
data type into Gerber Plotter format, CADMOVER will translate filled rectangles
by generating a series of pen strokes, using a proper aperture width, to create filled
rectangles in the generated file.
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For example, the following set of filled rectangles generated in MacDraw II:

will create the following shape in Gerber Plotter format.

Fig. 4-8: Gerber Plotter Drawing Construction

The gray fill in the top part of the above picture is used here to demonstrate how
the rectangles are overlapped. Because of the physical constraints of photoplotter
technology, the second shape in Fig. 4-8 cannot be generated by starting with a
black rectangle and overlaying a white “c” shape on it. That would result in an all-
black area, since CADMOVER considers all filled rectangles to be black when
generating photoplotter files.
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EPSF Output...

EPSF Details give you the power to specify how line caps and line joins will be
treated in files exported as EPSF.

CADMOVER offers you the option to control line joins and end caps when writing

files in Adobe Illustrator format. The “EPSF Details...” button in the Preferences
Dialog brings up another dialog box:

Adobe lllustrator™ output.

e 31 o 5
o 31 o =
o 3] o =

—Text
Mas. Font Size 144 Pt.

Min. Font Size 0.1 Pt.

—Document

Max. Document Size ln.

Fig. 4-9: The EPSF Output Dialog
Joins and Caps

In the above dialog the three diagrams in the left hand column indicate how lines
will be joined; the three diagrams in the right hand column indicate how lines will
be terminated.

It is not uncommon for lines which appear to be joined actually to be separate lines.
If you have such a file, it is recommended that you use either the round or
extended line caps, otherwise there will be a visible notch where two lines meet at

the corner.
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This picture shows how two lines will look if their endpoints are coincident but
they are not actually joined, and butt end caps (top right symbol in the dialog) are
selected. Selecting extended or round caps will make the lines appear to be joined.

Fig. 4-10: Lines With Butt End Caps
Text
The two fields in the Text section of the dialog let you specify the maximum and
minimum font size for the output file. This can be important when writing Adobe
Illustrator files, because Adobe Illustrator sets both upper and lower limits on the
size of font it is willing to work with. When it tries to read a file containing text
whose size falls outside those limits, it issues an error message, and refuses to read
the file.

Different versions of Adobe Illustrator have different limits. Also, several other
programs (such as Aldus Freehand and Corel Draw, for example, have different
limitations. If you encounter such limitations in the program you use to read EPSF
files, you can enter them into this dialog.

CADMOVER checks your output file as it is being generated. If the font size of any
text string falls outside the established limits, CADMOVER will show you a
message that gives the highest and lowest font sizes in the document as translated.
The following example was made by scaling an architectural floor plan of a house
down to less than postage stamp size:
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Texnt sizes range from
0.01 to 0.03 points,
but preferred range is
0.10 to 144.00 points

Fig. 4-11: Font Size Warning

You can use the numbers in this message to decide how to rescale your file. In this
case, since the dialog tells us that there is text as small as 0.01 points, and the stated
minimum point size is 0.1 points, the file should be scaled at least ten times larger.

Be aware that this is only a warning message, indicating that there probably will be
trouble reading this file into another application. Continuing with the same
example, this file was opened in Adobe Illustrator 3.2, and the following two
messages were produced:

Error content:00 110k

0110K

0.00002 w

/Courier 0.0284121 0.0284121 00 2

Fig. 4-12: Adobe Illustrator's First Error Message Relating
To A Text Size Violation
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contains an illegal operand. Offending
command: ‘2’

0 Can't open the illustration. The illustration

[_ox_J

Fig. 4-13: Adobe Illustrator's Second Error Message Relating
To A Text Size Violation

i
This acts a lot like the font size limits, but it applies to the size of the entire

document being translated. If you try to save a file whose size is in excess of the
stated maximum, CADMOVER will offer you the following choices:

Warning! Drawing
size exnceeds
stated marimum
width or height.

[" Cancel Translation |

( Proceed Anyway )

( Autoscale to Man )

Fig. 4-14: Document Size Overflow Choices

If you cancel the translation (the default choice), you can then use the “Scale...”
Dialog to resize your drawing, and then use “Save As...” to restart the translation.
You don't have to read the original file back in.

You may also choose “Proceed Anyway.” CADMOVER will have no trouble

generating EPSF documents of practically any drawing size, but be aware that
some other applications may not be able to read the file.
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The third option, “ Autoscale to Max,” has the same effect as if you had used the
Scale Dialog yourself to set the height or width (whichever is larger) of the drawing
to the value you've entered into the Max Document Size field of the Adobe
Ilustrator Output Dialog. In Figure 4-9 page 62, the maximum document size is
shown as 18 inches. Therefore, if you were to choose “Autoscale to Max,” then
your drawing will be scaled so that its larger dimension (height or width) is exactly
18 inches.

EPSF Input...

The EPSF Input ... Dialog can be useful when translating EPSF files into other
formats, especially DXF and DDES2.

In EPSF files, curves are almost without exception represented by Bézier splines.
When translating into a format that does not support Bézier splines, the curve will
normally be represented by a polyline composed of short, straight line segments
that approximate the path of the intended curve. The approximation can be as
close as you want to make it by increasing the value of the “Number of Spline
Segments” field on the main Preference Dialog. But this has the disadvantage of
vastly increasing the amount of data in the output file, and, for very close work,
still leaves a visibly “chunky” appearance to the curve.

By using the EPSF Special Edits, you can tell CADMOVER to translate Bézier

curves as true arcs, so long as the curves actually do follow a circular path within
some certain tolerance.

EPSF INPUT Special Edits

(X Recognize circular arcs

[ set Line Weights to Zero

[ use Polycurve in DRF
(] outlines Only

Arc Recognition Tolerance

Fig. 4-15: EPSF Input Dialog
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Recognize Circular Arcs

The first check box, “Recognize Circular Arcs,” tells CADMOVER whether you
want to generate arcs when possible. If this check box is left blank, then
CADMOVER will not even try to find any arcs, and all Bézier curves will be
translated in the usual fashion (i.e., as splines when possible, and as polylines
otherwise). But when this check box is turned on, CADMOVER will translate
splines as true arcs whenever they are close enough to the stated tolerance. The
tolerance value itself, which has meaning only when this check box is turned on,
controls how closely a curve must match a true arc before it is considered to be an
arc. The lower the value is, the more closely a curve must match a circular path
before it is translated as a true arc. In general, a value of 0.001 will be sufficient to
recognize any arcs that have actually been created with the circle tool in either
Adobe Hlustrator or in Aldus Freehand. In some cases, the tolerance needs to be
set as high as 0.075 to catch all curves that were actually intended to follow circular
paths, but if the value is set much higher than that, then some curves which were
not intended to be circular might be translated as true arcs. Conversely, if the
tolerance is set much lower than 0.001, then some curves intended to be circular
arcs might be missed.

Set Line Weights to Zero

The second check box, “Set Line Weights to Zero,” does exactly what its title
suggests. When the box is checked, CADMOVER will ignore any line weight
information in EPSF files it reads, and will consider all lines, whether straight or
curved, to have a zero line weight. This has several potential uses. For example, if
you intend to drive a die cutting machine with the translated file, you may obtain
superior results when the lines to be cut are infinitesimally thin.

Use Polycurve In DXF

The third check box, “Use Polycurve in DXF,” tells CADMOVER to represent any
arcs it has found as polycurves (instead of simple arcs) when writing DXF files.
Polycurves and simple arcs are for the most part totally equivalent, but simple arcs
cannot carry the line weight attribute, and polycurves can. Also, polycurves are
mathematically more complex than simple arcs, and some programs that read DXF
do not process polycurves correctly.

Arc Recognition Tolerance

The “Arc Recognition Tolerance” is discussed above, under “Recognize Circular
Arcs”. In general, if “Recognize Circular Arcs” is checked, then you will probably
want to have at least one of the other check boxes turned on, especially if you are
translating your data into DXF.
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Qutlines Only

The “Outlines Only” check box controls the way CADMOVER treats objects read in
from any PostScript file. When this check box is ON, CADMOVER ignores the fill
colors or patterns associated with area outlines. The outlines themselves are
carried as true Bézier curves, so that actual spline information can be written out in
any format which supports either Bézier or Parametric Cubic splines, such as IGES,
Dimensions, or Dreams. When the check box is turned OFF, CADMOVER carries
the area fills, but converts the outlines to polylines instead of spline curves. The
polylines will be a good fit for the original Bézier curve. This is usually the better
setting for formats which do not support Bézier curves, e.g., PICT.

Important Note: DXF Arc Simulation

I “Recognize Circular Arcs” is checked, but both of the other check boxes are off,
CADMOVER will do all the computations necessary to identify arcs, but then
when writing out a DXEF file, it will simulate the arc by using a segmented polyline
in order to preserve nonzero line weight. The same results can be obtained with
less computation by leaving the first check box blank.

PICT Output...
PICT File F e tion Opt

PICT files may be generated in various ways for various reasons. The PICT Format
Generation Options Dialog in CADMOVER gives you control over some of the
variables. You can modify the generation of Thick Lines, Conic Arcs, Area Fills,
and Border Pixels
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Thick Lines

CADMOVER normally generates thick lines in PICT format by setting the correct
pen size and then drawing a single line. This is usually what works best, but there
are situations in which the 'custom’ lines work better. The difference between the
“Standard” setting and the “Custom” setting is best illustrated by example: The
line on the left is Standard, the one on the right is Custom.

Surprisingly, even when “Custom” can appear to be the right choice for a file when
you are looking at a zoomed-in view, the same file may look better in a zoomed-
out view when “Standard” is selected. The only way to make this determination
for certain is by experimentation.

Conic Arcs

With the “Standard” selection for conic arcs, CADMOVER simply places an
appropriate “ARC” command into the output file. The arcs which are supported
by the PICT format, however, are limited to sweeps of a whole number of degrees.
This is usually not a problem for small arcs, but when the arc radius is more than
an inch or so, problems can begin to crop up, as the effects of rounding off all arcs
to the nearest degree become more evident. The most obvious manifestation of this
problem is that when an arc is supposed flow smoothly into a straight line
segment, the arc endpoint may not meet the endpoint of the line. That's why
CADMOVER provides you with the option of “Custom” arcs. When you select
“Custom” as the arc preference, CADMOVER carefully draws a series of small line
segments to approximate the arc. The finished product will still look like an arc,
even under very close scrutiny. And the endpoints of the arc will lie exactly where
they are supposed to. CADMOVER's internal arc mechanism is accurate to better
than one trillionth of a degree, so roundoff is not a problem when Custom arcs are
selected.

Areq Fills

Area Fills are divided into “Artistic” and “Mechanical/ Architectural”. These
appellations are largely arbitrary, but they do indicate the areas of endeavor likely
to influence your choice of technique regarding area fills. What the difference
really comes down to is that with “Artistic” area fills selected, CADMOVER adds
an extra one-pixel strip of the fill color on the right side and bottom edge of all
filled rectangles. This eliminates the problem of visible borders between areas
which really should be touching but are not touching because of roundoff errors
somewhere along the translation line. When “Mechanical/ Architectural” is
selected, no such extra pixels are added. Let experience be your guide in
determining which selection you want for this option.
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Border Pixels

This control is a tool for controlling the amount of margin placed in PICT files
written by CADMOVER. Most files look best when there is at least a small border
of empty space around them, so CADMOVER offers a default value of 36 pixels,
which, on most Macintosh screens, is one half inch.

Fig. 4-16: Standard And Custom Thick Lines

PICT Details

Thick Lines Area Fills
® Standard @ Artistic
O Custom O Mech./fArch.

Conic Arcs Arc Tension
@ Standard 4
O Custom

X PICT Version 1 Border Pisels
X Group PICT Data [36 I

X PICT Layers

Fig. 4-17: The PICT Format Generation Options Dialog

Figure 4-17 shows the PICT Format Generation Options Dialog. Of course, if you
click the “Cancel” button, any changes will not be recorded. When you click the
“OK” button, then CADMOVER will apply your new Preferences, and continue to
use them until you quit CADMOVER (if the “Save Settings” box is not checked), or
until you explicitly change the settings again (if the “Save Settings” check box is
checked.)
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PICT Version 1

CADMOVER normally writes PICT files using PICT Version 2, which offers a full
range of RGB color support, unless you are running on a machine which doesn't
have color. Usually, there's no reason not to use PICT 2. But there are a few
reasons:

«  For export to non-Macintosh machines
»  For use in programs which don't offer full RGB support

In general, if a program, on a machine which is not a Macintosh, offers to import
PICT data, that means PICT Version 1. This preference is provided to give you the
ability to communicate with such programs, while still allowing you to use the full
range of RGB color when communicating with programs which support it.

On the Macintosh, if a program can read a PICT Version 1 file, it can read a PICT
Version 2 file. But it might lose some color information. Colors are approximated
by their closest match out of black, white, red, green, blue, yellow, cyan, and
magenta. Unfortunately, it's not uncommon for light colors to be approximated by
white, which makes them invisible. When the PICT Version 1 preference is
checked, CADMOVER does its own approximations, and tries to avoid rendering
lines as white, unless they are truly white to begin with.

Group PICT Data

This preference controls the grouping of objects within PICT files written by
CADMOVER. When the option is turned ON, CADMOVER will collect all data in
a PICT file into a single group, so that when you arrive in the target program of
your choice, you won't have to go through the two step process of selecting all the
elements and then grouping them before you move the whole picture around.
Groups within groups are not affected by the addition of an upper-level group.
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PICT Lavers

Before you save your multi-layered file in PICT format, for each layer select all
objects and group them together. Then be sure that the PICT Layers preference is
turned on before you open the PICT file in CADMOVER. CADMOVER will create
a new layer in the output file for every top-level group in the input file, as long as
you save your file in a format which supports layers. CADMOVER will also make
a separate layer for all objects that are not grouped at all, if there are any.

A top-level group is simply a group which is not contained inside of any other
group. CADMOVER does not create layers for groups which are nested inside
other groups.

Important Note: Laver Creation

You can even use this feature to create layers where there were none before. If you
have a picture in a program which does not support layers, simply group objects
together into the layers which you would like CADMOVER to produce.

IGES Details...

IGES Details

IGES Version esin 5.0
IGES Font
B-Spline Order | Arbitrary

[ Interpolate IGES Splines
[J Aiternate Line Weights
[]More IGES Texnt

[J Create Symbols

[ create Hermite Surfaces

Fig. 4-18: The IGES Details Dialog
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IGES Version

You may select IGES Version 3.0, 4.0, 5.0, or 5.1 for the IGES files CADMOVER
writes. CADMOVER preserves the full amount of graphic information regardless
of which version of IGES you choose to create.

IGES Font

The IGES standard recognizes a number of text fonts. The IGES Font control
allows you to specify a preferential font for IGES files written by CADMOVER.
The available fonts are:

Standard Block
LeRoy

Futura

Comp 80

News Gothic
Lightline Gothic
Simplex Roman
Century Schoolbook
Helvetica
OCR-B

Symbol Font 1
Symbol Font 2
Drafting Font

The default selection is Standard Block. The font you select will be used for all
IGES output.

B-Spline Order

The B-Spline Order control tells CADMOVER whether to assume that all B-Splines
are quadratic, or to do the full processing required to compute curves and surfaces
for higher-order B-Splines. When the control is set to "Quadratic”, processing is
very quick, and will produce correct curves for the use of many Macintosh
applications. If splines of higher order are encountered, the paths they follow will
be approximate. This often produces acceptable, if not perfect, results. When the
control is set to "Arbitrary", CADMOVER brings some considerably more complex
math into play, which can have a noticeable effect on execution time. However, B-
Spline curves and surfaces of any order can be translated with complete accuracy.
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Interpolate Splines

This check box controls the way parametric cubic spline curves are represented
internally. When the check box is ON, CADMOVER will convert parametric cubic
splines into polylines as soon as it reads them. This generally results in faster
performance. However, if you are translating IGES to a format which directly
represents splines, leave this check box OFF. Performance will be a little slower,
but spline curves will retain their true representation as splines.

The control “Number of Spline Segments” (see page 52 ) determines the density of
the interpolation.

Al te Line Weight
The “Alternate Line Weights” check box is there to help overcome discrepancies in
the way different manufacturers encode line weights in IGES files. Basically, if you
translate an IGES file, and you find that lines are either far too thick or far too thin,
change the state of this check box and try again.

The PICT format does not support the concept of layers. But there is a way to
preserve layer information when you use CADMOVER to translate a PICT file
which was created by an application that does support layers.

More IGES Text

This preference may be used to overcome a problem which has plagued many
IGES users: missing text. A little explanation is in order.

The IGES Standard, as defined by the National Institute of Standards and
Technology, has been subjected to a wide variety of interpretations. As a result,
unfortunately, IGES now comes in “flavors,” each with its own peculiarities.

If you have an IGES file, which you know contains text, and some (or all) of the text
is missing from your output file after you've translated the IGES to something else
with CADMOVER, then try turning this preference on. CADMOVER will change
the way it looks for text in the IGES files it reads. In general, if you have an IGES
file which exhibits this “missing text” syndrome, it's likely that all IGES files from
the same source will have the same problem. Once this preference has been
checked, CADMOVER will treat all IGES files as “missing text” files, until you turn
off the preference.

Don't turn on this preference, however, if your IGES files are not missing any text.
Using “More IGES Text” when it's not needed will almost certainly cause too much
text to appear; a single text note may appear multiple times and at various places in
the drawing, when it should only appear once.
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Create Symbols

This check box allows CADMOVER to use predefined symbols and instancing
(IGES Entity Types 308 and 408). When this check box is OFF, CADMOVER will
“explode” all symbols into their component parts. But when the check box is ON,
CADMOVER will generate IGES files which may contain subfigure definitions and
instances.

Cregte Hermite Surfaces

This check box tells CADMOVER how to deal with parametric cubic (Hermite)
surfaces. When the check box is OFF, CADMOVER will convert Hermite surfaces
into a polygon mesh, according to the setting of the “Spline Mesh” control. The
polygon mesh will be written as a series of Type 106 (Copious Data) entities. When
the check box is ON, CADMOVER maintains Hermite surfaces as primitive objects,
and will write them into an IGES file using Entity Type 114 (Hermite Surface).

DXF Details...

e

DHF Details

DHF Units: Inches
DHF Version: Version 12

X Smooth DHF Ovals
[] 256 DHF Colors

Fig. 4-19: The DXF Details Dialog

DXF Units

With this control, you tell CADMOVER what measurement units are used for DXF
files which you read in. DXEF files are expressed in terms of pure numbers, without
reference to any measurement system. Therefore, a value of 7.5 could mean 7.5

millimeters, or 7.5 inches, or 7.5 kilometers. Unless you tell it otherwise,
CADMOVER will assume that DXEF files are in inches.
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The control is a popup menu. Select the measurement unit which describes the
DXF files you want to read. The unit you select will be used for all DXF files you
read, until you change the value again.

DXE Version

This popup control allows you to specify the version of DXF that CADMOVER will
write. Many programs, particularly 2D programs, cannot read DXF versions above
version 9. If you are writing DXF files for such a program, select Version 9 for
output. However, if you are interested in preserving full 3D information, and your
target CAD system can accept Version 10, 11 or 12 DXF files, then select the
appropriate version.

smooth DXF Ovals

The DXF format does not have any construct to represent an oval directly.
CADMOVER provides two different methods by which ovals may be represented
in DXEF files: either by using a large number of short, straight segments laid end to
end, or by using a circle which is disproportionately scaled to represent the original
oval. When the check box is ON, CADMOVER will used the “scaled circle”
method, and when the check box is OFF, CADMOVER will generate a segmented
polyline.

256 DXF Colors

The DXF standard can accommodate up to 256 colors. However, because the
displays of many common video monitors are limited to 8 colors, CADMOVER
offers the ability to match colors to the closest color out of a palette of eight colors:
black, white, red, green, blue, cyan, magenta, and yellow. If this check box is ON,
then CADMOVER will use the 256 color scheme to write DXF files. If the system
destined to receive the DXF files written by CADMOVER has a display limited to
eight colors, you may prefer to leave this check box OFF.
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Tessellation...

Tessellation

2D Tessellation affects DRF
output; 3D Tessellation affects
DHF and SCULPT 3D

[ 2D Tessellation
X 30 Tessellation

Fig. 4-20: The Tessellation Dialog

TESSELLATION is the process of tiling a plane surface. CADMOVER offers two
kinds of tessellation: 2D and 3D.

2D Tessellation

2D tessellation applies to DXF output. In general, closed areas with more than four
sides cannot be represented in DXF as filled areas. When you turn on 2D
tessellation, CADMOVER will create a number of smaller “tiles”, which it
strategically places into polygons and closed areas to fill them with a solid color.
Then, translations from such formats as PICT or CGM into DXF can maintain their
filled areas. When 2D tessellation is OFF, such areas are translated to DXF as
outlines only.

See Figures 4-21 and 4-22, on the next page, for a comparison of how graphics will

appear after rereading DXF files generated with different settings of the 2D
Tessellation option.
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Fig. 4-21: DXF Graphic Generated With 2D Tessellation Off.

Fig. 4-22: DXF Graphic Generated With 2D Tessellation ON.
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3D Tessellation

3D Tessellation is a similar issue which relates primarily to writing files in Sculpt
3D, Sculpt 4D, or ENVISAGE 3D formats. Object faces in Sculpt 3D format are
always composed of triangles only. When CADMOVER writes a file in Sculpt 3D,
all triangles from the input file become faces in Sculpt 3D, and all quadrilaterals are
divided along their shorter diagonal, yielding two triangles in Sculpt 3D.

But when faces in the input file (in whatever format it may be) have more than four
sides, the 3D Tessellation option comes into play. When 3D Tessellation is OFF,
faces with five or more sides will simply be outlined. When 3D Tessellation is ON,

CADMOVER divides every face of five or more sides into a series of coplanar
triangles, so that complex faces will render properly as faces.

HPGL Details...

HPGL Pen Colors and Weights

Select a color and a line weight for each pen

I g"' - Color [_Black )
Q2 Units |_Points ]
8 : width |1 |
Il [os (X Ignore PAGE FEED
06 [J Separate Layers
07 [0 save Settings
os| [ _J

Fig. 4-23: The HPGL Details Dialog

Pen Colors

Plotter files use different pen numbers to represent different colors. There is no
standard correspondence between pen number and pen colors, because an actual
plotter device may have pens of any color loaded into the various carousel slots by
the plotter operator. This dialog gives you the opportunity to select a color and a
line weight for each of the eight possible pens. For each of the eight pens, there are
eight possible colors, one of which is white. The default settings do not include
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white, because few plots actually require white pens. But since you will be
translating the plot file to another format, there may be reason to select white, and
the option is there if you need it. The available colors are black, white, red, green,
blue, cyan, magenta, and yellow.

m— — =

HPGL Pen Colors and Weights

Select a color and a line welght for each pen

Pen _ v Black
@1 White
02 Units Red j
G
O3 wisth | pye | ]
O4
& Ignor| Cyan
Os Magenta
o6 U Sepan) yojiow
gv| s
Os

Fig. 4-24: The HPGL Details Dialog With The Pen Colors Popup Menu Open

Figures 4-23 and 4-24 shows the Pen Colors and Weights Dialog. To use the
dialog, first click on a button in the left hand column to select the pen you wish to
modify. Then you can select a color and a line weight for that pen.

tin t
HPGL files do not inherently have a layer structure. But when you are translating
HPGL files to a format which does support layers, you may wish to separate the
drawing into layers. When the “Separate Layers” check box is on, CADMOVER
will assign drawing elements to different layers according to which pen is used.
This is independent of pen color — you may assign the same color to all the pens,
and CADMOVER will still segregate layers by pen number. If you do not want to
separate your plot files into layers, turn off the “Separate Layers” check box.

Line Weights

Since HPGL files do not carry information about how thick a line should be drawn,
it is up to you to specify line weight. Initially, all lines are assumed to be 1 point
(1/72 inch) thick. To modify the line weight, first use the Units popup menu to
select how you want to measure the line weight. You may select among Inches,
Centimeters, or Points. After selecting the units, type a line weight into the

CADMOVER 4.0 User’s Manual



Chapter 4 Preferences 79

“Width” box. CADMOVER will use the indicated color and line weight for the
selected pen.

As you select different units, the number in the Width box does not change. Be
sure that the number is expressed in the units you actually want.

HPGL Pen Colors and Weights

Select a color and a line weight for each pen

®1 Centimeters
02 ~Points
g : width |1
OS5 [X Ignore PAGE FEED
06 [J Separate Layers
07 [J Save Settings
E— )
os| (L& __

Fig. 4-25: HPGL Details Dialog With The Units Popup Menu Open.

Ignore Page Feed

In order to prevent the accidental merging of plots that are supposed to be
separate, CADMOVER will stop reading an HPGL file when it encounters a ‘PG’
(Page Feed) instruction. This plotter instruction tells the plotter device to eject the
current sheet of paper from the plotter bed, which effectively terminates the
current plot. It is not uncommon, however, to find plotter files that have a ‘PG’
instruction near the beginning of the file, to ensure a clean sheet of paper in the
plotter. When CADMOVER translates HPGL files set up in this way, if it were to
stop on every ‘PG’ instruction, it would result in empty output files, accompanied
by all-blank pictures.

If that happens to you, turn on the “Ignore Page Feed” checkbox. Then

CADMOVER will skip over ‘PG’ instructions in HPGL files as though they were
not there.
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Save Settings

The Save Settings check box allows you to assign a standard set of colors and line
weights to HPGL files. If the box is checked at the time you click on the OK button,
then CADMOVER will remember these settings and use them every time you
import an HPGL file. On the other hand, if the check box is left blank, then
CADMOVER will apply the colors and weights you have chosen to the current file
only, and will revert to the previous configuration the next time you import
another HPGL file.
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Placement...

This option refers to the placement of the translated document or model within the
target coordinate system.

CADMOVER gives you the option to specify how you would like your translated
documents or models to be positioned.

Placement

Format [ PICT |

@ Standard Settings

QO Leave Coordinates Unchanged
O set Minimum Ualues

QO Center Coordinate Values

H Axis (Width) 0
¥ Axis (Height) |0
Z Rxis (Depth)

Fig. 4-26: The Placement Dialog

Not all options are useful for all formats. For instance, if you specify that
coordinates are to remain unchanged when you translate DXF into PICT, some
programs may load the generated PICT image into an area that is off the page,
making it inaccessible to you. In some cases, this may even cause the program
which reads the PICT file to malfunction. Note: If STL files are positioned so that
any coordinates have negative values, it probably will not be able to be built by a
stereolithography (STL) machine.
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CADMOVER's default approach to document placement is as follows:

1. Forall 3D formats except STL, the model will be centered around (0,0,0).

2. For STL, the model will be placed entirely within the first octant, so that
the STL file will contain no non-negative coordinates.

3.  For PICT, MacDraft, and Dreams files, the file will be placed so that the
upper left corner of the drawing appears in the upper left corner of the
window of the corresponding application program.

4. For HPGL, the lower left corner of the plot will be placed at (0,0).

5. For other 2D formats, the document will be centered around (0,0).

There are two primary reasons for this placement scheme:

1.  So that translated models and documents will appear in a valid portion of
the coordinate space supported by the application that will read the files
created by CADMOVER.

2. To help you find your translated document or model after you have
opened it in another application. Particularly in 3D programs, it is
surprisingly easy for your model to be “lost in space.” Imagine opening
your translated model in a 3D editor program, and seeing only a blank
screen, even though a status window tells you that there are over a
thousand surfaces in the current model. If you don’t know what
coordinate values were in use in your model, it can be time consuming to
actually locate your model and position it within your program's working
space.

There are four basic placement options that can be used:

t d P

This is the factory default setting described above. Its action varies depending on
the output format, but will generally be the “right” thing.

Leave Coordinates Unchanged

This is almost certainly the option you will want if you are translating a model
from various parts files and intending to assemble all of the parts in some target
program while keeping their original relative placement to each other.

CADMOVER will leave the coordinate values absolutely unchanged so long as the
source program and target program use the same units of measurement (e.g.,
inches), and the same scale. Even if measurement units or scale do change,
translations involving multiple files will generate new files with the parts having
the same relative placement as they did before translation.
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Set Minimum Coordinate Values

This setting allows you to specify placement of a document or model, based on the
minimum coordinate values for each axis. The values you type in here, which are

expressed in the measurement system of the translated file, will be the minima for

each respective axis.

Set Center Coordinate Values

The values you type in here, which are expressed in the measurement system of the
translated file, will be the centers of each respective axis.

Note that when translating to any 2D format, the settings for the Z axis (depth) are
ignored, since 2D coordinate systems do not have a Z axis. When translating from
2D to 3D, the Z value for all coordinates may be set to any desired value (normally
zero.)

Maxima...

Uarious Madima

This panel controls the marimum number of
elements for the listed items

Polygon vertices (input) |20000 |
Polygon vertices (output)
Defined Symbols |8000 |

Fig. 4-27: The Maxima Dialog

In order to process large files efficiently, CADMOVER needs to allocate some
storage areas before it knows how big some of these areas have to be. The
assumptions that CADMOVER makes are adequate for most files, while still
allowing CADMOVER to run in a modest amount of memory.

If, however, you get a message from CADMOVER that there are too many blocks,
or that the maximum polygon size has been exceeded, etc., it is possible to
reconfigure memory and try again.

In addition, some programs which process files created by CADMOVER have their

own limitations. For instance, some applications that read Adobe Illustrator files
limit the number of vertices in a polygon to 1000. CADMOVER offers you the
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option to limit the number of vertices in all polygons written to an output file, so
that the application you intend to use next on that file will function correctly.

As of this writing, the maxima that can be set, are the maximum number of vertices
for a polygon on input, the maximum number of vertices for a polygon on output,
and the maximum number of symbols (a.k.a blocks) that can appear in a file.

Background...

Background Operation

FAST makes this application
faster at the expense of
others during background
operation.

@ FAST
O MEDIUM
QO sLow

Fig. 4-28: Background Speed Selection Dialog

Using The Background Operation Diglog

You can select one of three speeds: Fast, Medium, or Slow. These speeds refer to
the way CADMOVER itself will run. When you select Fast, CADMOVER will run
at nearly the same speed it does when it is the foreground task. When
CADMOVER is running Fast in the background, your foreground task may seem
somewhat sluggish or slow to respond to your commands. When you set
CADMOVER's background speed to Medium, it will take a little longer to translate
your files, but foreground applications will run normally, quickly responding to
your commands. If CADMOVER is running at Slow speed, the translations will
take even a little longer, but the background operation will have no effect at all on
foreground applications. Be sure to read the section in this manual about Batch
Mode operation in order to get the most benefit from background operation.
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Spline Mesh...

How many mesh units along each side
of a spline surface? The number must
be between 1 and 8.

Each spline surface will
make 16 rectangles

Fig. 4-29: The Spline Mesh Dialog

The Spline Mesh Dialog gives you control over how coarse or fine a mesh is
generated whenever Hermite surfaces are converted into a polygon mesh. It is
important to note that this control is active even if the “Create Hermite Surfaces”
check box in the “IGES Details...” Dialog is checked ON. In fact, if your input file
contains Hermite surfaces, you can interactively change the mesh parameter, and
observe the effect on the screen, before saving a file.

Parametric Cubic Spline Surfaces

CADMOVER deals directly with parametric cubic spline surfaces. Many of the file
formats which CADMOVER translates do not have a direct representation for these
entities. Therefore, when translating to such a format, CADMOVER approximates
spline surfaces as a collection of rectangles. The collection of rectangles which
represents a spline surface can be referred to as a “mesh”.

You can control the meshing density CADMOVER uses when it converts a spline
surface to rectangles. The lowest density results in a small file which both
translates and displays quickly. The highest density results in a much larger file,
which takes significantly longer to translate and display. For rendering purposes,
however, the higher density mesh gives vastly superior results.

The Mesh Density Dialog can be accessed by starting with the Preferences...
command, then hitting the “Spline Mesh...” button. The dialog asks for a number
between 1 and 8 (the default value is 4). The number represents the number of
segments into which each edge of the spline surface will be divided. The number
of individual rectangles that will be made from each spline surface is the square of
this number. Therefore, at the lowest setting, no subdivision at all takes place. The
entire spline surface will be represented by a single rectangle. (The word
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“rectangle” is being used rather loosely here; “quadrilateral” would be more
precise.) The default setting results in sixteen rectangles for each spline surface,
and the highest density mesh results in sixty-four rectangles for each spline surface.
From this, it is easy to see why file size and execution time may be strongly affected
by the mesh density setting.

Fig. 4-30: Mesh Density =1

Fig. 4-31: Mesh Density =4
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The two illustrations (Figures 4-30 & 4-31) on the preceding page illustrate the
effect of the Mesh Density Dialog. The top picture was done at the lowest density.
The boundaries of each spline surface are visible, but there is no interior detail
within the surface. The bottom picture was made from the same IGES input file,
with the default meshing density (4x4). Each individual spline surface is
represented by sixteen rectangles.

How many mesh units along each side
of a spline surface? The number must
be between 1 and 8.

Each spline surface will
make 16 rectangles

Figs. 4-32 and 4-33: The Spline Mesh Dialog At Its Lowest Setting,
And Below At Its Default Setting.

How many mesh units along each side
of a spline surface? The number must
be between 1 and 8.

Each spline surface will
El make 1 rectangle
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B

Fig. 4-34 Mesh Density = 1

The wireframe illustrations on this page and the next page also show the effect of
varying the mesh density. As in the previous figures, the object was translated first
with a mesh density of 1 (this page), and then again with a mesh density of 4.

The original model from which these figures were derived was produced on a

Schlumberger MacBravo! system, and saved as an IGES file. CADMOVER rotated
the object to the view you see here, then projected it onto a 2D plane.
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Fig. 4-35: Mesh Density = 4
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File Formats

Text vs, Binary

CADMOVER deals with a wide variety of file formats. Some of the file formats are
Text formats; others are Binary formats. The basic distinction between the Text and
Binary formats is that Text files can be opened in text editors, word processors, etc.,
and the contents are generally eye-readable. Binary files, on the other hand, cannot
be read or printed by a word processor.

Another difference between Text and Binary files on the Macintosh is that, in
general, binary files are closely associated with one and only one program, whereas
Text files are generic; i.e., it doesn't matter what program created a Text file; any
program which will open any Text files at all can generally be counted on to open
all Text files.

Selecting a File o Open

When you select “Open...” from CADMOVER's File Menu, a standard “Open...”
Dialog box appears. CADMOVER displays the name of every file in the current
folder which it believes it can process. If you know that a certain file is in the
current folder, and its name is not displayed in the list CADMOVER shows you,
then that file is not in a format which your copy of CADMOVER can process.
CADMOVER always displays all files in any binary format that it can translate. In
addition, it will display all files of type Text.

I th ter

Different computers may have slight variations in the way Text files are formatted.
Text files contain lines of text which are separated by line separator characters. The
particular line separator characters used are generally dependent on the originating
system. CADMOVER has been specifically designed to ignore variations in line
separator characters, so that no special processing is required to prepare a Text file
for use by CADMOVER. The only requirement is that the file's type be Text.

Automatic Format Recognition

As mentioned above, Binary files are usually tightly associated with one particular
program. Any binary file which is displayed in the list CADMOVER shows you
can be opened and translated. Since Text files are not associated with any
particular program or format, CADMOVER actually has to open the file and
perform some analysis of the file's contents in order to figure out what format the
file contains. If you select a file, and CADMOVER is unable to determine what
format the file contains, a message to that effect will be displayed, and the file will
be closed.
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3DGF Files

CADMOVER can both read and write files in 3DGF format. 3DGF is a 3D format
which describes objects composed of surfaces.

Colors

3DGF files may or may not carry color information. When a 3DGF file does have a
color value for each face, CADMOVER will use the given value; otherwise it will
assign the color black to each face. When CADMOVER writes 3DGF files, it will
assign a color to each face if there is any color information in the input file being
translated to 3DGF.

Non-Surface Objects
Things which are not surfaces, such as lines, open polygons, and text, are not
translated to 3DGF.

CADMOVER Reqds It All

CADMOVER is always able to represent surfaces. Since all the geometric entities
in 3DGF files are surfaces, CADMOVER can read and translate all of the geometry
in any 3DGF file.

Measurement Units

3DGF files do not actually have any measurement units. However, CADMOVER
treats them as though the units are centimeters. When you are writing a 3DGF file
from CADMOVER, it is generally a good idea to scale your model so that it will be
on the order of 5-10 cm in size before you save it.

Architrion 1l Files
CADMOVER can read files produced by Gimeor's “ Architrion II” application.
3D Only

Architrion II files contain exclusively 3D information, which consists of solid blocks
and holes through the blocks. CADMOVER translates all blocks as solids with
their surface normals pointing outwards from the body of the solid. Holes are also
translated as solids, but with their surface normals pointing inward toward the
center of the block.
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Colors

The colors used in Architrion II files are derived from the system color table on
whatever Macintosh was used to produce the original file. CADMOVER will
apply color to the models it reads in from Architrion II files. Whether it applies the
“right” colors is dependent on the similarity between the active color table on the
generating system and the active color table on the receiving system.

Eqch Block is an Object

CADMOVER treats each block within an Architrion II file as a separate object. This
will allow you to manipulate individual blocks after you've translated your
Architrion II file to another 3D format and you are working in whatever target
application you have chosen.

Input Only
CADMOVER only reads Architrion II files; it does not write them.

CGM Files
An Exchange Standard

The CGM (Computer Graphics Metafile) format is not associated with any
particular program. Rather, it is an exchange standard supported by the American
National Standards Institute.

2D

The CGM format is designed for the exchange of 2D drawing information. It does
not support 3D modeling.

Iext or Binary?

The CGM standard defines both a binary format and a clear text equivalent.
CADMOVER can be configured to read and write the binary format. It will not
read the clear text version of CGM.

Color Table Support

CGM files may contain color table information. If you have a CGM file which does
contain color table information, CADMOVER will faithfully reproduce it.

Machine Independent

CGM has been carefully specified in a way which makes it independent of any
particular hardware platform. Programs which have support for CGM can be
found on a wide variety of different computers, from small personal systems
through large mainframe computers.
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Check Your Measurements

CGM files optionally contain measurement information. When a CGM file does
contain measurement information, it's no problem for CADMOVER to tell exactly
how large the drawing should be. However, it is perfectly legitimate for a CGM
file to omit any reference to size; in other words, it could be correctly displayed at
any size, so long as the ratio between height and width is maintained.

Because most file formats are sensitive to real world measurements, it always pays
to take a look at CADMOVER's “Scale” Dialog after reading a CGM file, but before
translating it to some other format. If you don't set the scale yourself, the results of
the translation could be unpredictable.

Different Diglects

Ideally, CGM files should be completely interchangeable among any two programs
or machines which claim to support CGM. In practice, this is not the case.
Different vendors have taken different approaches to CGM, and some of the
language in the written standard is subject to some interpretation. CADMOVER
already modifies some of its heuristics based on the vendor identification in the
CGM file. If you have a CGM file which you feel is not being read correctly, please
call Kandu Software Corporation to let us know. You may have a CGM file in an
unknown dialect. If this occurs, the technical staff at Kandu Software would like to
become aware of a new dialect, in order to add a little more knowledge to the next
version of CADMOVER.

ClarisCAD Files

CADMOVER can read and translate the data in ClarisCAD files.

Text with Multiple Attribut
ClarisCAD gives you the ability to use different fonts, font sizes, and attributes
within a single text object. CADMOVER does not support multiple attributes
within a single text string; instead, it will use the font and font size from the first
character in the string. If you need to have exact font and font size information
translated, then Save your file in PICT format. You'll be pleased with the results.
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Laver Support

ClarisCAD supports named layers. CADMOVER gives full support for an
unlimited number of layers. The structure of the layers will be maintained when
translating to any format which has layers, and even the layer names will be
preserved when translating to formats which support named layers. When
translating to IGES, the layer structure is maintained, but layers will be numbered
instead of being named.

Higher Precision

Files stored in ClarisCAD format are capable of retaining a higher degree of
precision than files stored in PICT format. CADMOVER fully supports the
precision used by ClarisCAD.

DDES2/1T8.6 Files

General Information
The DDES2 (IT8.6) format is generally used to communicate the design of die-cut
objects. CADMOVER both reads and writes DDES2 files.

Design vs. Layout

DDES?2 files contain a Design section and a Layout section. The Design section
describes the actual geometry of the object contained in the file. The Layout section
describes how multiple copies of the design may be laid out on a larger sheet of
material, e.g., a sheet of vinyl, cardboard, or plastic.

When CADMOVER reads a DDES? file, it operates only on the Design section.
This means that you don't have to do any additional work to untangle the design
from the layout, such as deleting extra copies of the design, rotating to zero, etc. So
no matter how many copies of the design have been specified in the Layout section
of the DDES2 file, CADMOVER always ensures that you have one unambiguous
copy of the design to work with.

When CADMOVER writes a DDES2 file, it includes a Layout section which
specifies one copy of the design with no rotation, scaling, nor mirroring.

Bridges

DDES2 files often specify Bridges, i.e., gaps in a cut line. CADMOVER correctly
interprets bridge information in straight lines and in arc sections. Cut lines with
bridges in them will appear on the screen as dashed lines.
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Dimensions Files

Application Support
This format is for data exchange with the Design Dimensions application by Visual
Information, Inc.

The Dimen r

The Dimensions format is designed for 3D surface modeling. It is very useful for
representing smoothly curved surfaces. CADMOVER can be configured to both
read and write the Dimensions format.

Spline Surfaces

Dimensions files typically contain spline surfaces. Please read the section in this
manual about 3D Meshes for a more thorough treatment of this subject.

Color
Dimensions files carry color information. CADMOVER will correctly translate the
colors in Dimensions files into any other format.

riting Dimensions Fil
Since most 3D formats are designed to represent polygons, CADMOVER writes
polygons into the Dimensions format when you are saving a file in Dimensions
format. The Dimensions application has facilities to convert polygons into spline
surfaces automatically, so the transition from polygons to spline surfaces is an easy
one.

Dreams Files

A 2D Drawing Format
Dreams, from idd (Innovative Data Design), is a 2D drawing package.
CADMOVER gives full support to Dreams files.

Laver Support

CADMOVER is sensitive to Dreams' layer structure, and will faithfully copy
Dreams layers into any other drawing format for which layers are supported.
Conversely, if CADMOVER has read a drawing file in any format which has a
layer structure, the layers from the original drawing will be preserved when you
Save the drawing in Dreams format.

Custom Colors

CADMOVER gives full support to the custom colors available in Dreams. You
may create any colors you like; CADMOVER will get the same color into your
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output file. And when you are translating files into Dreams format, CADMOVER
will create the correct custom color table for you.

Line Stvies

CADMOVER also correctly reads and translates dashed lines from Dreams files.
And when translating into Dreams, CADMOVER will preserve the first sixteen
dashed line styles it encounters.

Home View

In order to maintain proper scaling, Dreams drawings should be saved when the
home view is active, i.e., not in a zoomed or custom view. When CADMOVER
creates a Dream:s file, the file will be created in the home view.

Spline Curves

Dreams can work directly with Bézier splines. CADMOVER represents these
splines correctly, and can maintain them as true Béziers when transferring data
among formats which support true splines, such as IGES and Adobe Illustrator
formats.

DXF Files

The DXF standard is promulgated by AutoDesk, Inc., the makers of AutoCAD®.
“DXF” is an acronym - it stands for “Drawing eXchange Format”. Although it was
originally designed to get data in and out of AutoCAD, the DXF format is now
used by a wide variety of programs. CADMOVER adheres to DXF standards
supported by AutoCAD; in short, if AutoCAD will read a DXF file, then
CADMOVER will read it, and conversely, if AutoCAD will not read a given DXF
file, then CADMOVER may not read it, either. For that matter, if AutoCAD won't
read the file in response to a “DXFIN” command, then that file is not considered by
CADMOVER to be a “real” DXEF file.

CADMOVER is generally more tolerant than AutoCAD is when reading DXF files.
A benefit of this fact is that DXF files which are rejected by AutoCAD itself can
sometimes be read in to CADMOVER, and then saved as DXF again. In so doing,
CADMOVER will “clean up” inconsistencies in DXEF files. The resulting “new”
DXF file is much more likely to be accepted by AutoCAD.
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DXF Version Must Be 2.54 or Higher

Note that the above statements apply to AutoCAD releases 2.54 and up. There is
an older flavor of DXF which was used by version 1.0 of AutoCAD; current
releases of AutoCAD won't read these obsolete files, and neither will CADMOVER.

Both 20 and 3D

DXEF files may represent 2D data or 3D data. CADMOVER deals with both
possibilities. When you are using CADMOVER to generate DXF files, be aware of
the setting of the “DXF Version” preference on the main “Preferences...” Dialog.
CADMOVER will restrict itself not to include any features in DXF files it writes
which are associated with a version number higher than the version you have
selected. That means that, on one hand, you can use CADMOVER to create DXF
files compatible with older versions of AutoCAD (or any other software which
reads DXF files), while on the other hand, you can also use CADMOVER to create
DXEF files which exploit the latest features of DXF. You can even use CADMOVER
to convert one of the later versions of DXF into an earlier version of DXF.

DXE Fi Usually Text Fil
When you are bringing DXF files into the Macintosh environment from some other
system, be aware that they are DXF Text files. No special reformatting is necessary
for CADMOVER to read the file; it already contains logic to adjust itself
automatically to be able to read text generated on many different systems.

In fact, DXF files may contain binary data instead of text data. CADMOVER reads
and writes either variation with equal aplomb. But in either case, no reformatting
is required.

Be sure to read the section in this manual about Line Terminators. The Line
Terminators setting applies to DXF files which CADMOVER writes.

fin ne Styl

The DXF format supports customized line styles. The style information for dashed
or dotted lines is copied exactly into IGES files. Dashed and dotted lines are
rendered as a collection of small line segments when translating DXF into a format
which does not support dashing. If you are translating into MiniCAD+,
CADMOVER offers you the facility to map line styles into one of the styles
available within the framework of those programs. See the section in this manual
about the Lines Menu for more information on this subject.
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Multiple Lavers

DXF also supports layers. CADMOVER gives 100% support to the layer
configuration within a DXF file. Within a DXF file, layers may be “frozen.”
CADMOVER explicitly ignores frozen layers in a DXEF file.

When CADMOVER is generating a DXF file based on input in a different format,
the layer names may have to be changed to fall within acceptable guidelines for
DXF layer names. CADMOVER does this automatically. It is careful to avoid
“collisions” between layer names which might otherwise occur if two layer names,
neither of which is a valid DXF layer name, were to be changed to the same new
name.

Binary DXF

CADMOVER reads and writes binary DXF files. To save a file in binary DXF
format, select “Binary DXF” instead of “DXF” from the format menu in the “Save
As...” Dialog.

ENVISAGE 3D Files

The ENVISAGE 3D program, from BYTE BY BYTE Corporation of Austin, Texas, is
a 3D modeling and rendering program which provides a full set of 3D editing tools,
and is capable of generating excellent photorealistic renderings.

20 or 3D — CADMOVER Does Both

CADMOVER both reads and writes the ENVISAGE 3D format. As its name
implies, ENVISAGE is a full 3D program. CADMOVER can move data to
ENVISAGE 3D from any other 3D format which it recognizes, including IGES and
DXF. In addition, CADMOVER can translate 2D data into ENVISAGE 3D format.

ENVISAGE 3D Extrudes 2D Data

2D data moved into ENVISAGE format can be easily extruded into the third
dimension by the ENVISAGE program.

T lating ENVISA ta to Other Format

CADMOVER offers two-way linkage to the ENVISAGE application. Models built
or modified in ENVISAGE 3D or ENVISAGE 4D can be exported to the full
spectrum of formats supported by CADMOVER. Full RGB color, measurement
units, and surface geometry are maintained for all translations.
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T llation

See the section in this manual about “3D Tessellation” to find out how you can
detail CADMOVER's translation of data into the ENVISAGE 3D format to either
include or exclude surfaces with five or more sides.

Focus Files

Even though CADMOVER can read and write Focus's text exchange format, it also
has the capability of reading and writing Focus files directly.

What' if n

Mostly, color. The Focus Text format does not support color, but the Focus format
does. CADMOVER can read the color information from Focus files, and when files
are translated into Focus format by CADMOVER, color information will be stored
in the file.

Time is also a factor. Using the direct Focus format is faster, both reading and
writing, for both the CADMOVER application and the Focus application.

Focus Text Files

Focus is a 3D modeling and rendering package from Abvent, of Paris, France.
CADMOVER has a bidirectional exchange capability with Focus Text files.

Text vs. Binary

Focus normally stores its files in a binary format, but it will alternately use the text
format. The advantage of using the text format is that it is much less subject to
change than the binary format; therefore, as time goes on, if you upgrade to a new
level of Focus, and the binary format has undergone changes, you can still continue
to use the same version of CADMOVER.

Discrete Objects

Focus works with 3D objects. When CADMOVER creates a Focus file, each set of
contiguous surfaces defines an object. It doesn't matter whether your input file
defines objects -- CADMOVER assembles them for you.

Color
The Focus Text format does not support color. All objects in a Focus Text file will
be treated as though they are black.
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Gerber Plotter Files

The Gerber Plotter format is a 2D file format used for the storage and transmission
of photoplotter data. Several attributes make this format unique, including the use
of apertures of various shapes and sizes, and the total lack of any color
information.

CADMOVER both reads and writes files in Gerber format. The list of aperture
descriptions is not embedded in the file itself, so another avenue is needed to
communicate aperture information.

Reading Gerber Files

When reading Gerber files, CADMOVER refers to the aperture descriptions
provided by the Preferences you've set up. See the section in this manual entitled
“Gerber Plotter...” in the “Preferences” chapter for a detailed description of the
aperture setup.

Wr r il

When writing Gerber files, CADMOVER produces a secondary file, in Text format,
describing the aperture setup it has generated for the output file. If you are
keeping a Log file, CADMOVER will place a copy of the generated aperture list
into the log file for reference. The aperture lists generated by CADMOVER are
suitable input for the AperText application program, which is also described in this
manual.

HPGL Files

CADMOVER can translate HPGL plotter files into any other supported format. In
order for CADMOVER to recognize an HPGL file, the file must either be of type
'Text', or the file's name must end in "HPGL'.

ked Text

Depending on the program which originated the plot file, text may either be
stroked or label text. Stroked text is actually composed of a large number of small
pen movements. The advantage of stroked text is that it will always look the same
on any computer, regardless of what fonts are available. The disadvantage of
stroked text is that it cannot be edited as text. Label text actually retains its identity
as text, and therefore can be edited as text after you translate the file to a different
format and open your drawing in the program of your choice. The disadvantage of
label text is that its appearance may change somewhat, depending on what fonts
are installed on your system. When translating label text in HPGL files,
CADMOVER will usually choose Courier font, if it is available, to represent the
text. If the Courier font is not available, CADMOVER will use the Monaco font,
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which is always available. If neither of these fonts are acceptable, you can use
CADMOVER'’s Font Mapping control to override the font assignments.

More Information
See the “HPGL Details...” section in Preferences chapter for more information
about manipulating HPGL files.

IGES Files

The IGES (Initial Graphics Exchange Specification) format is documented by the
National Institute of Standards and Technology. It is designed to be an exchange
format, and therefore has been designed to support a wide variety of graphic
concepts. IGES files are produced by many CAD systems, CAM systems, and other
software packages which deal with geometric concepts. IGES is an appropriate
standard for exchanging data among machines of different types, for instance,
mainframe to minicomputer or vice versa.

IGES files may contain 2D data or 3D data, or, as is often the case, they contain a 3D
description of a set of objects and instructions for laying out projections of those
objects on a 2D plane. CADMOVER deals with all of the possibilities mentioned
here.

Muifipls Didwines Parel

An IGES file may specify more than one drawing per file. Sometimes these
drawings are meant to be translated together, and sometimes they should be
translated separately. When CADMOVER opens an IGES file which contains more
than one drawing, it will show you a dialog panel with a check box for each
drawing in the file. Initially, all the boxes will be checked with an 'X', meaning that
all the drawings should be translated together. If you want separate translations,
click on the appropriate check boxes to remove the 'X', thereby telling CADMOVER
not to process the indicated drawing. Each check box will be accompanied by
either a number or a name. CADMOVER shows you the drawing name by each
check box if the IGES file includes that information, and shows you a sequence
number if the drawing name is not available.
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There are 3 drawings in this file.

Please select which drawing(s) you wish to
translate together.

XIC_SHT1
I C_SHT1_TEHT
XD_4103016_A_S01

Fig. 5-1: Multiple Drawings In A File Dialog.

GES Files Contain Plain Text

When you are bringing IGES files into the Macintosh environment, be aware that
they are Text files. No special reformatting is necessary for CADMOVER to read
the file; it already contains logic to adjust itself automatically to be able to read text
generated on many different systems.

IGES Has Dialects

The IGES standard has been subjected to various interpretations by different
vendors of IGES translators. This is to say that although IGES is one language,
there are many 'dialects'. CADMOVER is very tolerant of variations among IGES
implementations, often employing artificial intelligence techniques to smooth over
inconsistencies or ambiguities in such a way that the user isn't even aware that any
problems exist. Furthermore, most IGES files contain information which identifies
the program which created the file. CADMOVER uses that information to resolve
nuances of translation.
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Identifying th ' fanl

When CADMOVER writes an IGES file, you will be prompted for information to
put in the header of the file. This information is intended to identify the object
being represented, the person responsible for making the file, and the company or
organization with which the file is associated.

Information entered on this screen will be written in
the Globals section of the IGES file being created.

PRODUCT ID FROM SENDER | DRALING

PRODUCT ID FOR RECEIVER |DRAWING

AUTHOR [ TRANSLATION

ORGANIZATION [NONE

Fig. 5-2: The Drawing Origin Dialog

Be sure to read the section about Line Terminators on page 21 of this manual.
CADMOVER can generate files which are preformatted for use on almost any type
of computer you choose, so it is a good idea to be aware of how the Line
Terminator preference is set.

IGES Entities

The IGES standard defines a wide variety of entity types. Not all of the entity types
are recognized by CADMOVER; however, the vast majority of graphic data can be
expressed by combinations of the entity types which are supported by
CADMOVER. A list of these follows:

100 Circular Arc Entity. This entity is fully supported. CADMOVER recognizes
the difference between a full circle and arcs of other than 360°, and treats

each case accordingly.
102 Composite Curve Entity. The Composite Curve is fully supported.

104 Conic Arc Entity. CADMOVER implements all forms of this entity,
including the Ellipse, Parabola, and Hyperbola.
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108

110

112

114

116

118

120

122

124

126

128

134
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Copious Data Entity. Most forms of the Copious Data Entity are supported.
CADMOVER optimizes the translation of multiple connected line segments
for target formats which provide a multi-line data type.

Plane Entity. CADMOVER recognizes the Plane Entity, and can use it to
orient an associated curve or polygon on the surface of the plane.

Line Entity. CADMOVER fully implements the Line Entity. Standard fonts
(Solid, Dashed, Phantom, and Centerline) are supported for receiving
systems which can display these types. References to entities of type 304
(Line Font Definition) are currently ignored.

Parametric Spline Curve Entity. The linear, quadratic, and cubic forms are
supported.

Parametric Spline Surface Entity. The linear, quadratic, and cubic forms are
supported. For most output formats, CADMOVER translates the spline
surface into a polygon mesh. User control of meshing density is available.

Point Entity. CADMOVER fully supports the Point Entity.

Ruled Surface Entity. CADMOVER gives full support to the Ruled Surface
Entity.

Surface of Revolution Entity. This entity defines a swept surface indirectly,
by referring to an axis and a generatrix curve. CADMOVER supports it fully.

Tabulated Cylinder Entity. This is a compound entity, and it is supported by
CADMOVER. lt s strictly a 3D entity, but CADMOVER will project it on to
a 2D plane for export to a 2D format.

Transformation Matrix. This entity is central to IGES, and it is supported
fully. CADMOVER uses full 3D transforms for all internal calculations.

B-Spline Curve Entity. This entity is fully supported. Curves with any
number of control points may be specified.

B-Spline Surface Entity. CADMOVER reads all forms of the B-Spline Surface,
including quadratic, cubic, and higher orders.

Node Entity. This entity, used in Finite Element Analysis, is translated by
CADMOVER as geometry.

CADMOVER 4.0 User’s Manual



108

136

142

144

202

206

210

212

214

216

222

228

230

304

308
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Finite Element Entity. This supported entity is a grouping of Node entities
(see above).

Curve on a Parametric Surface Entity. CADMOVER reads all forms of the
Type 142 Entity. This entity is generally used in conjunction with the Type
144 (see below)

Trimmed Surface Entity. CADMOVER reads all forms of the Trimmed
Surface Entity. It will translate the entire surface to any chosen output
format.

Angular Dimension Entity. CADMOVER supports the Angular Dimension
Entity.

Diameter Dimension Entity. Fully supported.

General Label Entity. CADMOVER supports General Labels. See the notes
for type 212 (General Note Entity) below.

General Note Entity. IGES defines a wide variety of character sizes and
fonts. CADMOVER carefully selects a type font and font size which will give
the closest visual representation on the receiving system. In general, only
characters within the range of the standard ASCII character set will translate
exactly.

Leader (Arrow) Entity. CADMOVER supports the Leader Entity. At the
present time, all arrowheads are treated as the form 3 type (filled triangle).

Linear Dimension Entity. Fully supported.

Radius Dimension Entity. Fully supported.

General Symbol Entity. This composite entity may contain any number of
text items, leaders (arrows), and geometric items. Its intended purpose is
annotation. CADMOVER offers full support of the General Symbol.
Sectioned Area Entity. This entity is used to specify both solid and patterned
fills for closed areas. It may be associated with a Color Definition entity
(type 314) to specify a closed area filled with a solid color.

User Defined Line Style. CADMOVER supports the standard IGES indexed
line fonts as well as all variations of the user defined line style.

Subfigure Definition Entity. This is a powerful feature in IGES, and
CADMOVER gives it full support. In general, the Subfigure Definition entity
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corresponds to a symbol library entry. It is a composite entity, and may
contain references to any geometric entities.

User Defined Color. CADMOVER supports all manifestations of RGB colors.

Network Subfigure Definition Entity. The Network Subfigure Definition
Entity is closely related to the type 308 (Subfigure Definition entity).
CADMOVER treats both the type 320 and type 308 as symbol library entries.

Associativity Instance Entity. CADMOVER supports the Views Visible form
(form number 3) of the Associativity Instance Entity.

Drawing Entity. CADMOVER offers good support for the Drawing Entity.
IGES allows multiple drawings to be specified in a single source file;
CADMOVER recognizes these as separate entities, and gives the user the
option to select individual drawings for translation. Drawing scale and
placement on the page are controlled by the View entity (type 410), which is
also supported.

Property Entity. CADMOVER recognizes and supports forms 15 and 16
(Name and Drawing Size) of the Property Entity.

Subfigure Instance Entity. This entity is closely related to Entity 308
(Subfigure Definition Entity), and is fully supported by CADMOVER.

View Entity. CADMOVER uses the Orthographic Parallel Projection to
transform model space into view space. The View Entity may be used to
specify a scale factor for the transformation from view space to drawing
space, and a transformation matrix controls the placement of the view within
the drawing.

Rectangular Array Subfigure Instance Entity. This entity allows a subfigure
to be defined once, and then place multiple copies in a rectangular grid
arrangement. It is related to types 308, 408, 320 and 420. CADMOVER gives
full support to this entity.

Circular Array Subfigure Instance Entity. Very much like Type 412, except
that the copies will be arranged in a circular fashion. Fully supported.

Network Subfigure Instance Entity. CADMOVER treats the Network

Subfigure Instance entity as though it were a type 408 (see above), which
implies full support for this entity.
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MacArchitrion 3D Text Files

MacArchitrion, from Gimeor, is the predecessor to Architrion II. It can export 3D
models in a Text format, which CADMOVER can read.

Just Like Architrion Il

The main difference between Architrion II files and MacArchitrion 3D Text files is
quite simply that Architrion II files are native binary files, and MacArchitrion 3D
Text files must be exported from the MacArchitrion application before they can be
translated. All of the statements about color tables and solid blocks in Architrion II
files apply to MacArchitrion 3D Text files as well.

Erench and English

The MacArchitrion has been marketed in both French and English versions, and
this dichotomy is reflected in the Text files exported from MacArchitrion 3D: the
text files themselves are written in either English or French. CADMOVER reads
both.

MacDraft Files

wi I
MacDraft, from idd, is a 2D drawing package. CADMOVER gives full support to
MacDraft files.

Only Recent Versions

CADMOVER directly supports the reading and writing of MacDraft files at a
version level of no less than 2.0. In other words, CADMOVER writes MacDraft 2.0
files and reads MacDraft 2.0 files. If you are using a version of MacDraft whose
version number is less than 2.0, CADMOVER can still help you. All you have to do
is use PICT format instead of MacDraft format. But the 2.0 (and higher) levels of
MacDraft support many features which cannot be readily expressed in PICT
format, such as multiple drawing layers.

Layer Support

CADMOVER is sensitive to MacDraft's layer structure, and will faithfully copy
MacDraft layers into any other drawing format for which layers are supported.
Conversely, if CADMOVER has read a drawing file in any format which has a
layer structure, the layers from the original drawing will be preserved when you
Save the drawing in MacDraft format.

Custom Colors

CADMOVER gives full support to the custom colors available in MacDraft. You
may create any colors you like; CADMOVER will get the same color into your
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output file. And when you are translating files into MacDraft format, CADMOVER
will create the correct custom color table for you.

Line Styles

CADMOVER also correctly reads and translates dashed lines from MacDraft files.
And when translating into MacDraft, CADMOVER will preserve the first four
dashed line styles it encounters.

MacDraw |l Files
CADMOVER can read and translate the data in MacDraw II files.

Text with Multiple Attribut

MacDraw II gives you the ability to use different fonts, font sizes, and attributes
within a single text object. CADMOVER does not support multiple attributes
within a single text string; instead, it will use the font and font size from the first
character in the string. If you need to have exact font and font size information
translated, then Save your file in PICT format.

Laver Support

MacDraw II supports named layers. CADMOVER gives full support for an
unlimited number of layers. The structure of the layers will be maintained when
translating to any format which has layers, and even the layer names will be
preserved when translating to formats which support named layers. When
translating to IGES, the layer structure is maintained, but layers will be numbered
instead of being named.

Higher Precisi
Files stored in MacDraw II format are capable of retaining a higher degree of
precision than files stored in PICT format. CADMOVER fully supports the
precision used by MacDraw II.

MiniCad+ Text Files

The MiniCad+ application, from Graphsoft, Inc., is the successor to MiniCad, and it
offers many more features and tools. CADMOVER can read and write Text files in
MiniCad+'s own internal scripting language, which is called MiniPascal.

E ting F Minicad
In order to write a MiniPascal file from the MiniCad+ application, select

“Export...” from the File Menu in MiniCad+, and then select “Text Format” from
the submenu that pops up. If you are working in 3D in MiniCad+, and you have
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sweeps or extrusions in your document, then before you export your file from
MiniCad+, follow these steps:

1.  Be sure that you have saved your document before exporting it.

2.  Select all sweeps and extrusions, and use the 3D tool “Convert to Mesh”
on those objects.

Export the file as above.

Close your document without saving it (unless you want to keep the effect
of the “Convert to Mesh” operation).

3.
4,

The file you have exported can be read by CADMOVER.

rting | ini
After CADMOVER has exported a file in MiniCad+ Text format, launch the
MiniCad+ application, and select “Text Format” from the submenu appended to
the “Import...” item on the File Menu in MiniCad+. Then select the file which you
exported from CADMOVER.

Yersions

The MiniCad+ Text files written by CADMOVER can be imported into any version
of MiniCad+. CADMOVER can read MiniCad + Text files written by all versions of
MiniCad+ up to version 3.1.

Attributes

CADMOVER maintains all geometric attributes when reading or writing
MiniCad+ Text files. Color, line weight, arrowheads, and layer attributes are all
there. And symbols stay symbols.

PICT Files

ifferent Versi ict
At the time of this writing, there are two “flavors” of PICT files: the original PICT 1,
and the newer PICT 2 format. Most of the time, the distinction between PICT 1 and
PICT 2 is not important.

The basic difference between the two formats is that PICT 2 supports a full range of
RGB color, while PICT 1 does not. PICT 1 does support eight basic colors: black,
white, red, green, blue, magenta, cyan, and yellow.

CADMOVER reads either format with equal aplomb. If you are running on a
machine which does not support Color QuickDraw, and you are reading a PICT 2
file, the RGB colors within the file will be mapped to the closest match out of the
eight colors listed above.
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Bitmaps

The PICT format does support bitmaps. CADMOVER does not. Therefore, when
you are using CADMOVER to read a PICT file which contains bitmaps, the
bitmaps will be ignored. If you need to translate bitmaps to other formats, you'll
need to use a program which can turn a bitmap into vectorized PICT before
running CADMOVER. One such program is Super Paint from Silicon Beach.
Super Paint has an AutoTrace feature which lets you take outlines of bitmaps and
save them as lines and curves into a new PICT file. CADMOVER will be able to
process the new PICT file in a meaningful way.

Pict Is “Built In"
As mentioned above, PICT is the “native” format of the Macintosh. The Macintosh
operating system contains built-in routines for dealing with PICT objects. This is
why you can successfully read a PICT 2 file on a monochrome Macintosh. But
other computers don't have this kind of built-in support for PICT. Some programs
which run on other computers claim that they can import Macintosh PICT files. In
almost all cases, this means PICT Version 1 only. CADMOVER has a feature
designed to deal with this situation: the PICT 1/PICT 2 switch. Even on a color
Macintosh, you can generate PICT Version 1 files. For more information about
PICT versions, see the sections in this manual about the Options Menu and the
Preferences Dialog.

Diiliit S8 e

Because of the way data are stored in PICT files, there is a maximum size limit
imposed on drawings. If you have a file in some other format, which represents a
drawing larger than 200 inches in either direction, you will probably need to scale
it down using the Scale Dialog from CADMOVER's Options Menu. In fact, if your
drawing exceeds this limitation, and you do not use the scaling dialog yourself,
CADMOVER will automatically scale its output PICT file down so that the
maximum size represented in the file falls within these limits. A message to that
effect will be placed in the Log file whenever CADMOVER does invoke automatic
scaling. Either one or both of the options “Show Log File” or “Keep Log File” must
be turned on in order for you to see this message. If logging is turned off, you may
be unaware that CADMOVER has invoked automatic scaling. But in any case,
even if your input file depicts objects many kilometers across, the output PICT file
will be able to contain all the geometry which was expressed in the input file.
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Drawing Accuracy

PICT files are expressed in PIXEL units. Each pixel is 1/72” (inch). For this reason,
no matter what unit system is used in your input file, CADMOVER always
translates measurement units to inches, with an accuracy of 1/72, when you are
writing a PICT file.

Getting Rid Of Jagged Edges In PICT

Sometimes drawings which were made at a larger scale, or with a program which
supports very high drawing accuracy, look a little rough when they are translated
to PICT format. There is a technique which may help you avoid that rough, jaggy
look. Suppose you have a drawing in some other format (not PICT), which is 18"
high and 24” wide. You want to bring this drawing into a drawing program which
is able to support fairly high accuracy, but it only reads its own format and PICT
files. Use the “Scale...” Dialog in CADMOVER to increase the drawing size to
something larger — for example, a magnification of 4X would bring your 18" x 24"
drawing up to 72” x 96”. Now Save the file in PICT format, import it into your
high-accuracy drawing program, and use the facilities provided by that program to
reduce the drawing size to 25% — to undo the effect of magnifying 4X in
CADMOVER. The resulting accuracy will be four times as great as that normally
afforded by the PICT format. Instead of being represented to the nearest 1/72 inch,
your drawing will now be represented to the nearest 1/288 inch — a vast
improvement!
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Postscript Files

CADMOVER can read files produced by Adobe Illustrator 88, and translate them
into virtually any format you like. It works equally well with black and white files,
or full color files. In addition to Adobe Illustrator 88 files, CADMOVER can also
read PostScript files exported from Aldus Freehand 2.0.2, EPS Exchange, Super 3D,
Schema, MicroStation, AutoCAD®, and a few other sources.

PostScript Diglects

CADMOVER does check the creator ID which is placed in every PostScript file by
the creating application. If the creator ID is missing, or is not one recognized by
CADMOVER, then CADMOVER will display a message telling you that the dialect
is not recognized. The Technical Support group at Kandu Software will be happy
to look at your PostScript file to determine whether a new translator for that dialect
can be added to CADMOVER.

ill r v lin

Many users will be interested in translating filled areas as such. However, if you
are interested only in the line work, and are translating to IGES format, there is an
option within the Preferences Dialog which will tell CADMOVER to ignore the
area fills. When the area fills are ignored, the smooth curves represented in the
Illustrator file will be translated as true spline curves. Otherwise, the boundaries of
areas which are both filled and curved will be translated as polylines.

Screen Appearance

If you are translating filled areas, and you are running on a machine which does
not have a color monitor (or if your monitor is set to monochrome mode), then
CADMOVER will use a dithered pattern to represent different colors or gray levels
on the screen. If you then translate the file to PICT format, you may be surprised to
see the screen turn solid black. This happens because, even though dithered
patterns are used on the screen, CADMOVER places color information into any
PICT files it writes. After a file has been saved in PICT format, CADMOVER
displays the actual PICT data from that file on the screen. In monochrome mode,
most colors other than white appear as solid black.

Wiiting Adobe lllustrator Files

CADMOVER can also translate a wide variety of file formats into a form
compatible with Adobe Illustrator. To translate files into an Illustrator compatible
format, first be sure that the “PostScript” popup menu in the Preferences Dialog is
set to “Illustrator”. Then, in the “Save As” window, choose EPSF.
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A f r

Many CAD programs work in real world units, so that, for instance, a floor plan of
a building could actually be several hundred feet in size. CADMOVER always
automatically sizes drawings to fit on the screen when it displays them. When you
save these files in PostScript format, it is important to scale them to fit on paper.
This usually means the size of a single sheet of paper; some users may have
drawings as large as poster size. Use the Scale Dialog from the Options Menu to be
sure that your drawing is scaled to the right size before saving it as a PostScript file.

The Nlustrator 88 program from Adobe has a maximum window size of eighteen
inches square. However, it will work with drawings which are larger than the
window size. We recommend that you scale your drawings down to no more than
eighteen inches on a side before translating them to Hlustrator format, so that you
will not have any trouble locating the picture when you open it in the Illustrator
program. (A large drawing may lie entirely outside of the visible window). So
long as you record the scale factor you use in CADMOVER to reduce the drawing
size, you can use Illustrator's scaling tool to restore the original size. Remember
that the scale factor in CADMOVER is a reduction factor, and the scale factor in
Adobe Tllustrator is an enlargement factor. So, for example, if you tell
CADMOVER to reduce your drawing by 4-to-1, then after you open the drawing in
Adobe Illustrator, you can enlarge it by 400% to restore the original drawing size.

Printer PostScript

When the PostScript control in the Preferences Dialog is set to “Printer”,
CADMOVER will save PostScript files in a format which can be placed in almost
any page layout program, and ultimately sent to a PostScript printer device, such
as a LaserWriter or a Linotronics printer.

Screen Graphic Included Automatically

A “picture preview”, suitable for use on any Macintosh, is automatically included
in saved PostScript files. The preview can be used by other programs (such as
desktop publishing applications or word processors) to position PostScript
graphics within a page.
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Presenter Professional Files

Application Support
This format is for data exchange with the Presenter Professional application by
Visual Information, Inc.

he P t fessl

The Presenter Professional format is designed for 3D surface modeling. It is very
useful for representing smoothly curved surfaces. CADMOVER can be configured
to both read and write the Presenter Professional format.

Spline Surfaces

Presenter Professional files typically contain spline surfaces. Please read about 3D
meshes in the Spline Mesh section, page 86, for a more thorough treatment of this
subject.

Color

Presenter Professional files carry color information. CADMOVER will correctly
translate the colors in Presenter Professional files into any other format.

Writi Pr Professional Fil

Since most 3D formats are designed to represent polygons, CADMOVER writes
polygons into the Presenter Professional format when you are saving a file in
Presenter Professional format. The Presenter Professional application has facilities
to convert polygons into spline surfaces automatically, so the transition from
polygons to spline surfaces is an easy one.

Sculpt 3D/4D Files

The SCULPT 3D program, from BYTE BY BYTE Corporation of Austin, Texas, is a
3D modeling and rendering program which provides a full set of 3D editing tools,
and is capable of generating excellent photorealistic renderings. SCULPT 4D is
essentially the same program, with animation controls added, so that entire movies
can be produced.

2D or 3D - CADMOVER Does Both

CADMOVER both reads and writes the SCULPT 3D format. As its name implies,
SCULPT is a full 3D program. CADMOVER can move data to SCULPT 3D from
any other 3D format which it recognizes, including IGES and DXF. In addition,
CADMOVER can translate 2D data into SCULPT 3D format.
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SCULPT Extrudes 2D Data
2D data moved into SCULPT format can be easily extruded into the third
dimension by the SCULPT program.

Iranslating SCULPT Data to Other Formats

CADMOVER offers two-way linkage to the SCULPT application. Models built or
modified in SCULPT 3D or SCULPT 4D can be exported to the full spectrum of
formats supported by CADMOVER. Full RGB color, measurement units, and
surface geometry are maintained for all translations.

Iessellation

See the section in this manual about “3D Tessellation” to find out how you can
detail CADMOVER's translation of data into the SCULPT format to either include
or exclude surfaces with five or more sides.

Stereolithography (STL)

The STL format describes 3D objects that can be built using a stereolithography
machine. STL files can be formatted either as Text files or as Binary files.
CADMOVER reads and writes both types. The files themselves represent
geometry only; they contain no information about surface attributes such as color
or texture.

Reading STL Files

CADMOVER makes it very easy to read STL files. In fact, there are no options at
all that affect the reading of STL files. CADMOVER will automatically recognize
whether any given STL file is in Text or Binary format, and adjust itself
accordingly. STL files are suitable for translation to any 3D format. It is generally
expected that all of the facets in any STL file face outward from the object of which
they are a part; therefore it is not necessary to turn on the “Two Sided Surfaces”
option when translating STL to other 3D formats. In fact, you should be sure that
the “Two Sided Surfaces” option is OFF before translating STL into other formats.

Of course, you may also translate STL files into any 2D format supported by
CADMOVER.

Valid vs. Buildable

An STL file may contain all valid data, yet still not produce a buildable model.
Producing buildable models is the ultimate goal when writing STL files. A “valid”
file is one that is correctly formatted and is internally consistent. But to be a
“buildable” model, more criteria must be met. In order to be buildable, a model
must be comprised of one or more nonintersecting closed surfaces. Furthermore,
within each surface, each face must be a triangle, facing outward, and each face
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must be unique. The model must lie entirely within non-negative coordinate space.
Lastly, the model must be composed in such a way that no uninterrupted edge of
one face passes through a corner point between two or more other faces. Several of
these rules may be summarized by saying that all edges in the model must be
shared by exactly two faces, no more, no less.

CADMOVER automatically takes care of many of these conditions. First of all,
tessellation is automatic. That means that if you have read in a 3D model that
contains surfaces with four or more sides, CADMOVER will automatically replace
those surfaces with an equivalent set of triangles. Duplicate surfaces, if there are
any, are eliminated automatically. Then, a validity check is performed to be sure
that all edges are shared by exactly two triangles. Surfaces which pass this test are
deemed to be “closed” surfaces. Finally, once a surface has been determined to be
a closed surface, CADMOVER then performs a facet alignment operation on the
surface, to be certain that all facets are facing outward.

Wiiting STL Files

CADMOVER can produce STL Text files and STL Binary files. Except for the
distinction between text and binary files, it makes no difference to CADMOVER
which variety you choose to generate.

It is strongly recommended that you turn on the “Show Log File” preference in
CADMOVER before writing out any STL files. This is because CADMOVER writes
a status report into the log file, describing any problems encountered during
translation, and ultimately issuing a declaration of whether the file appears to
represent a buildable model.

Placement

In order to be buildable in most stereolithography machines, all of the coordinates
in the model must be nonnegative (i.e., zero or positive.) You can use
CADMOVER's Placement option to ensure that STL files written by CADMOVER
appear in the proper coordinate space.

Super 3D Files

SUPER 3D, from Aldus Corporation, can import and export properly formatted
text files. CADMOVER both reads and writes this format.

Bringing 2d Info 3d
SUPER 3D is strictly a 3D program. CADMOVER can convert data drawn in a 2D
program into a form usable by SUPER 3D. Lines, arcs, and open polygons are

converted into 3D lines, and closed figures such as circles, ellipses, rectangles, and
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closed polygons are converted into 3D polygon faces. Of course, CADMOVER also
imports all 3D constructs from other programs into SUPER 3D.

SUPER 3D considers polygon faces to be one-sided; i.e., each polygon has a distinct
“front” and “back” side. The sidedness associated with a closed face is generally a
function of the direction in which it was drawn; objects which were drawn in a
clockwise fashion will face a direction opposite to those objects which were drawn
in a counterclockwise fashion. This becomes important when you want to view an
object as a solid within SUPER 3D.

When you are bringing files in from other systems, there's usually no way to tell
how the faces are oriented. How can you be sure that all the polygons in your file
have compatible directionality? The answer to that is the “Two Sided Surfaces”
switch on CADMOVER's Options Menu. Be sure to read the section in this manual
which describes that feature in detail. Briefly, it is usually a good idea to have this
option turned ON when you are using CADMOVER to translate data into SUPER
3D format. When the switch is ON, CADMOVER will generate two polygon faces
(one in each direction) for each closed object in the input file. Then, no matter how
you rotate your model once it has arrived in SUPER 3D, you will always be looking
at the “front” side of each face.

Wavefront (.OBJ)

A Eil

CADMOVER can read and write Wavefront Object (.OB]) files containing polygon
data. In order to be recognized as a Wavefront file, the file must be of type Text,
and its name must end with “.OBJ".

These files describe 3D geometry only. They do not contain any information about
texturing, color, or any other surface attributes such as transparency or luminance.
When CADMOVER reads such a file, it assigns a default color (black), which is
used for translations to other formats that do contain color information.
Conversely, when writing .OBJ files, any color information associated with the file
is omitted, since there is no way to represent it.

Different Computers

Wavefront software generally runs on UNIX systems. Therefore, if you will be
writing Wavefront files, it is generally a good idea to set the “Line Terminators”
preference to UNIX. When reading Wavefront files, CADMOVER automatically
adjusts itself to whatever line terminators the file contains, so no special translation
is necessary before CADMOVER reads the file.
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Zoom Text Files

Zoom is a 3D modeling and rendering package from Abvent, of Paris, France.
CADMOVER has a bi-directional exchange capability with Zoom Text files.

Text inar

Zoom normally stores its files in a binary format, but it will alternately use the text
format. The advantage of using the text format is that it is much less subject to
change than the binary format; therefore, as time goes on, if you upgrade to a new
level of Zoom, and the binary format has undergone changes, you can still continue
to use the same version of CADMOVER.

Di te Object
Zoom works with 3D objects. When CADMOVER creates a Zoom file, each set of
contiguous surfaces defines an object. It doesn't matter whether your input file
defines objects — CADMOVER assembles them for you.

Color

The Zoom Text format does not support color. All objects in a Zoom Text file will
be treated as though they are black.

Zoom Files

Even though CADMOVER can read and write Zoom's text exchange format, it also
has the capability of reading and writing Zoom files directly.

What's the Difference?

Mostly, color. The Zoom Text format does not support color, but the Zoom format
does. CADMOVER can read the color information from Zoom files, and when files
are translated into Zoom format by CADMOVER, color information will be stored
in the file.

Time is also a factor. Using the direct Zoom format is faster, both reading and
writing, for both the CADMOVER application and the Zoom application.
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AutoCAD® DWG Files

It is unusual to document things that a program will not do, but here is an
exception to that rule. CADMOVER does not process DWG files created by
AutoCAD. If you want to translate a drawing made by AutoCAD, you must use
either the DXFOUT command or the IGESOUT command in AutoCAD to export a
file in either DXF or IGES format. CADMOVER will be able to process either type
of exported file.
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Batch Mode Processing
Batch Mode and Scripting

CADMOVER can process a group of files easily, without having to open and Save
each one individually.

How To Do It

First, be sure that your Preferences are set the way you want them to be. Most
users will want to run with Display Picture turned OFF (because nobody will be
looking at the screen anyway), and Keep Log File turned ON (so you can get a
report of how your translations progressed). Once your Preferences have been set,
quit the program and return to the Finder.

Be sure that there is plenty of disk space on your target volume before starting
multiple translations.

»  System 7 Users
First, select all of the files you want to translate. Then drag this group of
selected files right on top of the CADMOVER icon, and release the mouse
button. This technique is known as “Drag and Drop”.

*  System 6 (or earlier) Users
Select all the data files you wish to translate, and select the CADMOVER
application. Double-click on the application to set the translations in motion.

If you are not an experienced Macintosh user, then refer to your Macintosh owner's
manual for information on how to select multiple files at one time.

CADMOVER will start up and begin reading a file. When the first file has been
read in, the “Scale...” Dialog will appear. ALL THE DRAWINGS IN A BATCH
WILL BE SCALED BY THE SAME SCALE FACTOR. Select the scale factor you
want, and click OK. Then the “Save As..." Dialog will appear. Select the output
format you want, and also select the output volume or folder where the translated
files will be put. All of the translated files will be placed into the same folder or
volume you select at this time. Since CADMOVER automatically generates a new
name for each output file, there will be no need to assign names to each file.

After the last file has been processed, CADMOVER will go in to its normal
interactive mode, waiting for instructions from you.
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Ihe Easy Way

The easiest way to translate a batch of files is to have two folders (perhaps on
different disk drives, if you have more than one hard drive attached to your
system). Place all the files you want to translate in one folder, and place the
CADMOVER application in the same folder. Then, from the Finder's File Menu,
issue the Select All command (or type command-A), followed by the Open
command (or type command-O). CADMOVER will start up and begin reading
files. When the “Save As..." Dialog appears, select the output file format you want,
and direct the output to the second folder.

It You Change Your Mind
If you hit the “Cancel” button in the “Save As..." Dialog, the entire batch will be
canceled. No translations will take place.

Multile Formats In Batch Mode

It doesn't make any difference how many different input types there are; you may
select a group of files consisting of IGES, DXF, SCULPT 3D, MiniCad + Text, etc., all
in the same batch. CADMOVER will automatically determine the format of each
file. Remember, though, that the same scale factor will be applied to all the files
you translate.

CADMOVER's batch processing option is easy to use, but does not always provide
the detailed kind of control you might like over a series of unattended translations.
To run batches of files with more control on a per-file basis, CADMOVER provides
a scripting feature.

Using CADMOVER's Scripting Feature

A script is actually a text file containing a series of conmands. CADMOVER reads
and processes the commands one at a time, in the order in which they appear. The
commands, listed alphabetically, are:

BEEP
FORMAT
MOVE
QUIT
SCALE
SOURCE
TARGET
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Eile Naming Rules
Some of the commands require file names or format names. The following rules
apply to all file or format names:

1.

If the name contains any blanks or special characters, it should be enclosed
in quote marks, which can be single quotes ('), double quotes (“), or
“smart” quotes () and (“).

The format names should be spelled exactly as they appear on the popup
menu in the “Save As...” Dialog.

If the name is the name of a folder (see SOURCE and TARGET commands,)
then the last character in the name should be a colon ().

If it is a file name, it may be fully qualified. This means that you can
specify the entire name of the file, including any folders that the file is in.
For example, MYDISK:MYFOLDER:MYFILE is a fully qualified file name,
assuming that the disk MYDISK contains a folder named MYFOLDER, and
that that folder contains a file named MYFILE.

Optional operands are introduced by a hyphen followed by a letter.

Available Scripting C |
BEEP Causes the computer to emit a BEEP sound.

FORMAT Specifies the target format that files will be translated into.
MOVE Names the file or files to translate.

QUIT Quits execution of CADMOVER.

SCALE Specifies an enlargement factor.

SOURCE Specifies the folder where input files are to be found.
TARGET Specifies the folder where output files are to be placed.
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Scripting Detall
In the following list, optional operands are enclosed in square brackets. Words in
italics should be replaced by an appropriate name or value. Any other text should

be used verbatim.

* BEEP

This command has no operands. Just place the word BEEP on a line by itself.

. FORMAT formatname

Specify the format into which files are to be translated. For example,

FORMAT IGES
or
FORMAT 'SUPER 3D'

All MOVE commands which appear in the script following a FORMAT
command will translate files into the format specified here (unless the MOVE

command contains the “-f” option.
+ MOVE filename [-f formatname)[-o outputfilename][-s scale]

The MOVE command is the one that really does the work. In its simplest form,
it tells CADMOVER to translate the named file into the format specified on the
most recent FORMAT command.

The “-f” option lets you put a format name right on the same line with the
MOVE command. For example,

MOVE myfile.dxf -f IGES

tells CADMOVER to translate the file “myfile.dxf” into IGES format, regardless
of the most recent FORMAT command.

The “-0” option specifies a file name for the output file. For example,

MOVE myfile.dxf -o yourfile.abc

tells CADMOVER to translate the file “myfile.dxf”, and name the output file
“yourfile.abc”.
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The “-s” option specifies an enlargement factor to be used by this command
only. For example,

MOVE myfile.dxf -s 0.5

tells CADMOVER to translate the file “myfile.dxf”, using a scale factor of 0.5,
which results in a 2:1 reduction.

The optional operands can appear in combination, so that you can specify any
or all of the options right on the command line.

QUIT

This command should appear on a line by itself. It causes CADMOVER to
quit.

SCALE enlargement factor

This command specifies a scale to use when translating files. The default value
is 1 (no scaling.) This scale factor will be in effect until the next Scale
command, or the end of the script, whichever comes first.

SOURCE foldername
The SOURCE command tells CADMOVER where to look for files. If you don't

use the SOURCE command, then CADMOVER will look for files in the same
folder where the CADMOVER application is located.

TARGET foldername
The TARGET command tells CADMOVER where to put translated files. If you

don't use the TARGET command, then CADMOVER will put output files in
the same folder where the CADMOVER application is located.

Comment Lines

To enhance readability, you can put all-blank lines in the script. You can also put
in comments containing any text you like by placing an octothorpe character (¥) at
the beginning of the line.

# These are sample comment lines.
# CADMOVER will ignore them.
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Important Note: Keeping a Batch Processing Log

When CADMOVER operates from a script, it will echo the script commands into
the Log file. It is strongly suggested that before running a script, you set up
CADMOVER's Preferences to include either “Show Log File” or “Keep Log File” or
both. Furthermore, if you do not choose to keep the log file, you probably should
not use the QUIT command, because if you do, then CADMOVER will quit as soon
as the last translation is complete, closing the log file window as it quits.

Running the Script
In order to run a script, first launch CADMOVER, and then select “Run Script...”
from the File Menu (or type command-R) The dialog box that appears will list all
files of type Text. Choose your script file, and click on the Open button.
CADMOVER will immediately begin to execute the script.

ScriptMaker ScriptMaker™

The ScriptMaker™ application, which comes with CADMOVER, is designed to
assist you in creating scripts. Start up ScriptMaker and you'll see a window that
looks like this one.

-

<
( Batch Translation Setup... ) (Comment...] (Beep ) (End Script

Fig. 6-1: ScriptMaker's Main Window In Normal Mode.
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ScriptMaker Expert Mode

Choose "Expert Mode" from the windows menu and the window will change to
look like this:

= scriptMoker™” e e

| &
&
(‘scale... ) (Format... | (Moue File... ] (Comment...) (Beep ] (End Script]

Fig. 6-2: ScriptMaker's Main Window In Expert Mode.

Each one of the buttons at the bottom of the window corresponds to one or more of
the CADMOVER script commands. For each of the first buttons in Normal mode
(those with three dots,) when you click on the button, you will be prompted for
more information appropriate to that command. In particular, clicking on the
“Move File...” button will display a standard “Open” dialog box. Choose the file
you want to translate. The MOVE command, including the file you have selected,
will be placed into the script. In Normal mode, clicking the large "Batch
Translation Setup..." button will display a dialog where you can set three of the first
CADMOVER script commands ("Move File...", "Format..." and "Scale...", at the same
time.

The “End” button places a “Quit” command in the script. (It is named “End”
instead of “Quit” to avoid confusion with the command that quits ScriptMaker.)

ScriptMaker does not offer a “Source” or “Target” button, because it always places
fully qualified file names into the script, thereby obviating the need for those
commands.

You may make your own edits right in this window, just as in any other text editor.
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Qpening An Existing ScriptMaker File

ScriptMaker has no “Open” command. To do further work on a previously
created script, choose “Import Text...” from the File Menu.

B

Fig. 6-3: The ScriptMaker Document Icon

E= Choose files BDBVee———=

(Choose Files...]

i o

X scale

“ Output Format [ Adobe lllustrator 88 w|

Fig. 6-4: The Choose Files Dialog.

Under System 7, CADMOVER offers special treatment to scripts that were created
by ScriptMaker: You can drag the icon of a ScriptMaker document on top of the
CADMOVER icon, and drop it. CADMOVER will recognize that the file is a script
file instead of a graphic image, and process it accordingly. This will not work with
scripts created by other programs. To run those, you will have to start
CADMOVER, and choose “Run Script...” from CADMOVER's File Menu.
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Sample Script

s |

o Exw;c Script ()

MOVE “C70:

MOVE “C70:YF12A.168”

SCALE 3

MOVE “C?0:Models:SMALL .STL” -f “300F~
MOVE “C?0:Models:BIG.STL”

MOVE “C70:Models:MEDIUM.STL”

MOVE “C?70:Models:MEDIUM.STL” -s 1 -0 “NOSCALE.DXF”
BEEP

BEEP

BEEP

QIT

—

O
(‘scale... ) (Format... ] (Move File... ] (Comment...) Beep ] (End Script

Fig. 6-5: A Sample Script

In this example, seven files are to be translated. The script starts with a comment,
which can be any text at all. Then comes the SCALE command, which sets the
enlargement factor to 12 for all subsequent translations until the next SCALE
command. The FORMAT command specifies that all files will be translated into
DXEF.

The next three MOVE commands call for translation of two EPSF files from one
folder, and an IGES file from a different folder.

The next command, “SCALE 3,” tells CADMOVER that the enlargement factor for
the following translations is to be 3.

Then, the file “SMALL.STL” is to be translated into 3DGF. (Note the -f on the
command line. This temporarily overrides the selection of DXF as the output
format.) After that, “BIG.STL” and “MEDIUM.STL" are both translated into DXF.

For the last translation, “MEDIUM.STL"” is translated again, but this time with a
scale factor of 1 (note the -s in the command,) and the resulting output file will be
named “NOSCALE.DXF” (note the -o in the command.) Finally, CADMOVER will
BEEP three times and then quit. The translations have been done.
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AperText

Fig. 8-1: The AperText Application Icon

AperText is a Macintosh application which converts text files into aperture
description files compatible with Kandu Software's CADMOVER® application.

Each line in the source file should contain four numbers:

1. D-Code

2. Shape code (1,2,3,4) = (square, rectangle,circle,ellipse) respectively
3. Aperture width

4. Aperture height

The measurement system for the aperture width and height is the same as the
measurement system being used for the plotter geometry. See how your Gerber
Preferences are set up in CADMOVER before filling in these fields.

The width and height may contain decimal points. The D-Code and Shape code
may not.

There should be four numbers on each line. The preferred separator characteris a
comma, but blanks or tabs are OK as well. Each line should end with a single
carriage return character, but the program will accept MS-DOS files (carriage
return AND line feed) or UNIX files (line feed only) as well.

The first line in the file describes aperture number 1, the second line describes
aperture number 2, and so on.

For example, the following lines describe an aperture list with 5 apertures:

10,1,25,;25
11,2,29;1%
12,2,50,100
13,3,10,;10
14,4,25,10
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The first line represents aperture number 1. Its D-code is 10, the shape is square,
and the size is 25 plotter units on each side. Aperture number 2 has D-code 11, it is
rectangular, 25 units wide and 75 units high. Aperture number 3 is also a
rectangle, 50 units wide and 100 units high. Aperture 4 is a circle 10 units in
diameter, and aperture 5 is an ellipse 25 units wide and 10 units high.

You can use any text editor (such as TeachText) to create an aperture list like the
one above.

When you launch AperText, it will immediately show you an “Open...” Dialog,
listing all files of type Text. Choose the file you want to translate. The translation
is automatic, and the “Open...” Dialog will appear again. Then you may choose to
translate another aperture list, or quit. (The escape key on the keyboard will
activate the Quit button.) The generated output file will be named after the input
file, with “. APERTURES” appended to the end.

You can launch CADMOVER using the new aperture list simply by double-
clicking on the aperture list icon. CADMOVER will use the apertures in that file

until you quit the application or change the aperture Preferences within
CADMOVER itself.

Fig. 8-2: The Icon For The Aperture List File Created By AperText
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Troubleshooting

Overview

This section lists some possible areas of difficulty that might be encountered during
the file translation process. In most cases, problems with the translation can be
resolved by changing the settings of one or more controls in CADMOVER.

Part 1 — Things That Can Happen When Files Created By
CADMOVER Are Read In To Other Applications

« Adobe lllustrator

This is a cryptic message, but it indicates that there is some problem with a text
item in the input file. Usually, it is an indication that a text font size has become
either too large or too small. Sometimes, it can occur if you have done a font
mapping operation, and have specified a target font name that contains blanks.

—Response
Check your settings in CADMOVER's “EPSF Output” dialog, page 60. These
can help CADMOVER identify sizing problems. If you have used any font
names that contain blanks, consider using a different font.

w H "

This is a sizing problem. What this message really means is, “Your file will not
print on the largest sheet of paper that this program can handle.”

—_Response

Use CADMOVER's “Scale” dialog, page 27, to reduce the size of the file. Make
sure that no dimension within the file is greater that 220 inches.

A lystrator - isi t n Scr

The most likely cause for this is that your file has not been scaled down enough. If
the file took a while to open, but you see nothing on the screen, then there probably
is artwork in the file, but the default view is zoomed in on a blank area.
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—Response
You can retranslate the file with CADMOVER, or, for a possible quick fix, you
can Select All and then use the magnifying glass tool to scale your entire file
smaller.

« Aldus Freehand
Al - "Too Many Point *

__Response
Use CADMOVER'’s “Maxima” dialog to set the maximum number of vertices
for an output polygon to 1000 or less. See page 84 for more information.

» AutoCAD

Curve Into Line Segments - lllustrator > DXF
“It was a curve in Adobe Illustrator, but now it's made of a bunch of short line
segments.”

— Response
If the curves were originally circular segments, turn on “Recognize Arcs” in the
“EPSF Input...” dialog. (Be sure to read the section in this manual that
describes the “EPSF Input...” dialog, page 64.) For curves that are not
intended to be truly circular, the conversion process will produce POLYLINE
structures in DXF. The “Number of Spline Segments” field in the Preferences
window can be increased to produce a larger number of shorter segments,
which can make the curve appear smoother. See page 52 for “Number of
Spline Segments” information.
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Part 2 - Unexpected Events That Can Happen When Files Of
Dubious Origin Are Read In To CADMOVER

Problem — Blank Screen
The “Display Picture” Preference is turned on and no picture appears on the
screen.

—Response

Turn on the “Gray Background” option. This problem is caused by drawing
all-white graphics on a white screen. When the screen background turns gray,
the graphic should appear. See page 50 for more informatjion.

Problem — Misplaced Text
(Dreams, MacDraft) The graphics look OK, but all the text is out of place.

—Response

The file probably had not been saved in “1X” view. Reopen the file in the
application that created it, and change the view magnification to 1X.

- i t
A PostScript or EPSF file has an unrecognized dialect.

The file you have
opened appears to
be in EPS format,
but the dialect is not
i recognized. It
cannot be
translated.

CADMOVER can open PostScript or EPSF files generated in a wide variety of
applications, notably Adobe Illustrator, Aldus Freehand 2.0, AutoCAD, and
MicroStation. But, PostScript files can take many forms, each of which
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constitutes a dialect if you see the dialog above, it indicates that CADMOVER
is able to recognize the format of your file, but does not know the dialect.
Unfortunately, what this means is that CADMOVER will not be able to
translate this file.

Kandu Software Corp. encourages users who have files like this to send copies
of the files in for analysis. It is sometimes possible to make minor changes to
the files to make them acceptable to CADMOVER. In any case, if you do send
a file, please include a note with your name, address, phone number, and the
reason you are sending the file.

roblem — i rawin
The translated output file is larger than the maximum set in the “Maxima “
Preferences Dialog.

0 Warning! Drawing
size exceeds
stated marimum
width or height.

( Proceed Anyway

)
( Autoscale to Man ]

The drawing size exceeds the maximum size specified by the “EPSF Output”
preference dialog. Depending on what you intend to do with the file, it may or
may not be useable. The most common way to get this dialog is to forget to scale
when translating DXF into EPSF. It is important to remember that the limit that's
been exceeded is only a caution limit; CADMOVER is just warning you that your
file's drawing size may be larger than you expected it to be.
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—Response
The buttons in the “EPSF Output” dialog list the possible actions.

«  Cancel Translation: This halts the translation, but leaves the input file
open and untouched so that you may use the Scale dialog to scale your
drawing.

+  Proceed Anyway: This is not necessarily a bad idea. But if you try to
open the resulting file in an application such as Adobe Illustrator, and you
get a message along the lines of “invalid or missing % %BOUNDING
BOX”, try translating the file again at a smaller scale.

«  Autoscale to Max: This button tells CADMOVER to scale your file such
that the larger of its width and hieght does not exceed the value specified
by the drawing size limit. You can inquire or change the drawing size
limit by using the “EPSF Output...” button in the main Preferences
window (command-;).

Either the hard disk or the floppy disk has run out of space during a file
translation.

of space while writing file "' . After
you click the 0K button, the program
will quit. Try to free up some space

i on the disk, and start CADMOVER®

' again.

0 The disk is full! CADMOUER® ran out

This message appears when the hard disk that contains CADMOVER's output file
fills up. In this example, “X” is the name of the output file. CADMOVER is not
able to recover from this condition, so it will quit after you click the OK button.
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Response
Either free up space on the hard disk you are using, or direct CADMOVER to
place the output file on a different hard disk.

CADMOVER reports an internal memroy allocation error using the dialog below.

Internal Memory Rllocation
Error! This may be a bug inside
CADMOUVER®. Please send a
copy of the file "H* to Kandu

Software, along with a bug
report form. Sorry for the
inconvenience,

This message indicates fairly serious trouble with your translation. Very often, this
message is the result of reading a corrupted file into CADMOVER. But sometimes,
it can result from a valid file. In either case, the makers of CADMOVER would be
happy to take a look at whatever is causing the problem. See the section on
Trouble Reporting (page 152) for information on how to send a file to Kandu.

Before you send a file, however, please check to make sure that the file is of a
version that CADMOVER can accept. For example, CADMOVER does read Adobe
Illustrator 88 files, but not Adobe Illustrator 5.0 files.

—_Response

If you are sure that your file is an appropriate version, and it has not been
corrupted, please send it to Kandu.
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CADMOVER does not recognize the file type you would like to translate.

e

| am unable to determine
the format of this file. The
file will be closed.

This message appears when you ask CADMOVER to open a file whose format is
unknown to it. In general, CADMOVER will only put files of known types into the
list of files shown in the “Open...” dialog. But several formats are normally stored
in files of type TEXT, including DXF, IGES, HPGL, and others. Therefore,
CADMOVER will attempt to open any file of type TEXT.

—Response
Check your file to be sure that it has not been corrupted. If you are trying to
translate an HPGL file, be sure that the file’s name ends with “.HPG”, since
CADMOVER will use that suffix as a clue in determining the file’s format.
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Trouble Reporting

If you are having a problem that cannot be rectified using any of the suggestions
above, please put your input file on a floppy disk, and send it to the Technical
Support Department at Kandu Software Corporation.

Be sure to include the following information:

Your name.

Your address.

Your telephone number.

A general overview of the problem.

The format of the file you are trying to translate.

The format you are trying to translate into.

The scale factor you are using (if you are scaling your file).

The exact model of computer you are using, e.g., Mac Ilci, 80MB hard disk,
8MB RAM, etc..

The System level you are using, e.g., System 6, System 7.1, etc.

The settings of any options that may have a bearing on the translation, e.g., if
you are translating an Adobe Illustrator file, indicate the settings of the “EPSF
INPUT...” dialog.

Also, it is particularly useful if you can provide a printed picture of what the file is
supposed to look like.

In general, the more detailed information you can provide, the more quickly your
problem is likely to be resolved.

Send the disk and other information to:

Kandu Software Corp.

131 Great Falls Street, Suite 100
Falls Church, VA 22046

Attn: Problem File

The “Attention” line is very important. Without it, your package may not receive
the attention it deserves.
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Appendix

Chapter 9

CADMOVER Reqads All of the Following Formats:

3DGF

Adobe Illustrator 1.1
Adobe Ilustrator 88
Architrion II

CGM

ClarisCad
DDES2/1T8.6
Dimensions

Dreams

DXF Binary

DXFv. 92D & 3D)
DXF v. 10 (2D & 3D)
DXFv.11 (2D & 3D)
DXF v. 12 (2D & 3D)
ENVISAGE 3D

EPSF AutoCADv.11
EPSF AutoCAD v.12
EPSF Freehand v. 2.02
EPSF Gplot

EPSF Harvard Graphics
EPSF ICIS

EPSF Mecca

EPSF MicroStation
EPSF Mitre

EPSF Pro Engineer (vector only)
EPSF Schema

Focus
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Focus Text

Gerber Plotter

HPGL

IGES v.1.0 (2D & 3D)

IGES v. 2.0 (2D & 3D)

IGES v.3.0 (2D & 3D)

IGES v. 4.0 (2D & 3D)

IGES v.5.0 (2D & 3D)

IGES v.5.1 (2D & 3D)
MacArchitrion

MacDraft

MacDraw II

MiniCad+ Text v. 1.0 (2D & 3D)
MiniCad+ Text v. 2.0 (2D & 3D)
MiniCad+ Text v. 3.0 (2D & 3D)
MiniCad+ Text v. 4.0 (2D & 3D)
PICT

Presenter Professional

SCULPT 3D 2.0

SCUPLT 3D 1.0

STL (Stereolithography)

STL Binary

Super 3D Text

Wavefront (.OBJ)

Zoom

Zoom Text
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R Writ rmats:
3DGF IGES v. 3.0 (2D & 3D)
Adobe Illustrator v. 1.1 IGES v. 4.0 (2D & 3D)
Adobe Illustrator v. 88 IGES v.5.0 (2D & 3D)
Adobe Illustrator v. 3.0 IGES v.5.1 (2D & 3D)
Adobe Illustrator v. 5.0 MacDraft
CGM MiniCad+ Text v. 1.0
DDES2/1T8.6 MiniCad+ Text v. 2.0
DXF Binary MiniCad+ Text v. 3.0
DXFv. 92D & 3D) MiniCad+ Text v. 4.0
DXF v. 10 2D & 3D) PICT
DXF v. 11 (2D & 3D) Postscript
DXF v.12 (2D & 3D) Presenter Professional
Dimensions STL
Dreams STL Binary
ENVISAGE 3D SCULPT 3Dv. 1.0
Focus SCULPT 3D v. 2.0
Focus Text Super 3D Text
Gerber Plotter Wavefront (.OBJ)
HPGL Zoom
IGES v. 1.0 (2D & 3D) Zoom Text
IGES v.2.0 (2D & 3D)

wing Progr
rogram EFormat Import/Export

Adobe Illustrator EPSF R/W
Anvil 5000 IGES R/W
Aperture DXF R/W
Archicad DXF R/W
Architrion II Internal, Text R
Ashlar Vellum IGES, DXF, PICT R/W
AutoCAD DXF, IGES, HPGL, EPSF~ R/W (EPSF R/Only)
BluePrint DXEF, PICT R/W
CADAM IGES R/W
CadKey IGES R/W
Canvas IGES,CGM,DXF,HPGL, R/W

EPSF, PICT
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CATIA
ClarisCad

Corel Draw
Design Cad 2D/3D
Design Studio
Die CAD
Dimensions
Douglas CAD
Dreams
DynaPerspective
Electric Image
ENVISAGE 3D
EPS Exchange
Focus

Form-Z
FrameMaker
Freehand
Generic Cadd
GPLOT

Harvard Graphics
HiJaak

ICIS

Infini-D
Intergraph
Interleaf

Laser Point CAD
MacArchitrion
MacBravo!
MacDraw II
MacLink Pro
MacProject
MacroMedia Three-D
MacSurf
MapGrafix
MarcoModel
Mecca
MicroCadam
Micrografx Designer
MicroStation
MicroStation
MiniCad+
Misomex

Mitre
Modelshop

MS Word

Chapter 9

IGES

Internal, PICT
CGM,DXF,HPGL, 111.88
DXF

EPSF

DDES2
Internal

IGES

Internal, PICT
DXF

DXF, Wavefront, IGES
Internal

EPSF
Internal, Text
DXF

EPSF, PICT
EPSF, PICT
DXF

EPSF

CGM, EPSF, HPGL
DXF

EPSF

DXF

DXEF, IGES
EPSF

DXF

Internal, Text
IGES

Internal, PICT
DXEF, PICT
PICT

3DGF

DXF

DXF

3DGF

EPSF

DXF, IGES
DXF

DXEF, IGES
EPSF

DXF, HPGL, EPSF, Text
DXF

EPSF

DXF

EPSF, PICT
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R/W
R,R/W
R/W
R/W

R/W
R/W
R/W
R/W
R/W
R/W
R/W

R/W
R/W

W,R/W
R/W

R/W,R
R/W

R/W
R/W

R/W

R/W
R,R/W
R/W
R/W
R/W
R/W
R/W
R/W

R/W
R/W
R/W

R/W
R/W

R/W



Pagemaker
Presenter Professional

Pro Engineer

Quark Express
Ragtime

Ray Dream Designer
Schema

SCULPT 3D/4D
Sculpt Model
Sketch

Stratavision
StreamLine

Super 3D

Touch 3D
Unigraphics II
Ventura Publisher
VersaCAD

Virtus Walkthrough

Wavefront
Zoom

Chapter 9

EPSF

Internal, DXF,
Dimensions

EPSF

EPSF

PICT

PICT, 3DGF

EPSF

Internal, DXF, 3DGF
DXF, 3DGF

DXF, PICT, EPSF, IGES
IGES, DXF, PICT, EPSF
PICT, EPSF,DXF
Text

DXF

IGES

EPSF, CGM, HPGL
DXF, IGES

DXF, ClarisCad,
MacDraw 11

.OBJ

Internal, Text

Appendix 153

R/W

R/W
R/W

R/W
R/W
R/W
R/W
R/W
R/W
R/W*
R/W

R/W
R/W,R,R

R/W
R/W

*Compatibility is based on customer registration card information and interviews
with a variety of CADMOVER users during January and February 1994 and all of
1987, 1988, 1989, 1990, 1991, 1992, 1993.

All programs and formats are the property of their respective companies or

associations.
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Index

2D Tessellation 75
3D Tessellation 77
3DGF 94, 132

A
Absolute Scale 53
Abstract Scaling 52
Active File 14, 15
Adobe Illustrator 17, 60, 61, 62, 64, 65,
83,99, 115, 116, 139, 140, 141, 144
Writing Illustrator Files 115
Aldus 119
Aldus Freehand 61, 65, 115, 140, 141
Alignment 119
Alternate Line Weights 72
Anti-Virus Checkers 10
AperText 58,103, 135
Aperture 57, 103, 135, 136
Apertures Dialog 56, 57
Aperture List Icon 136
Aperture Lists 103
Aperture Numbers 54
Aperture Setup 103
Aperture Shapes 56
Aperture Sizes 54
Arc 64, 65, 66, 67, 119
Arc Recognition 66
Arc Sections 97
Circular Arc 65, 106
Architrion IT 94, 95, 110
Area 18, 28, 49, 75, 139
Area Entity 108
Area Fills 66, 67, 115
Area Outlines 64
Array 109
Arrow 14, 108
Arrowheads 108, 112
ASCII 108
Assumptions 24, 83
Asymmetric Line Control 56
AutoCAD 122, 140, 141
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A
AutoCAD DWG Files 122

Automatic Format Recognition 93

Autoscale 64, 143
Autotrace 113
Axis 31, 32, 33, 83, 107

B
B-Spline 71, 107
B-Spline Order 71
B-Spline Surface 107
Background Operation 36, 84

Batch Mode 36, 84, 124. 125. 130
Multile Formats In Batch 125

Beep 36

Bézier Curves 52, 64, 65, 99
Binary 93, 100, 101, 110, 118
Bitmaps 113
Black-And-White 30

Block 83, 84, 94, 95, 110
Border Pixels 68
Boundingbox 139

Bridge 97

Buildable 118

Butt End Caps 61

C

Cancel 63, 68, 125, 143
Canceling An Operation 20
Caps 60, 61

Carousel 77

Carriage Return 37, 135
Centerline 107

CGM 37, 38, 52, 53, 75, 95, 96
Circular Arc 65, 106
Circular Path 64

Circular Segments, 140
ClarisCad 96, 97

Clipboard 14, 15, 29

Close Box 17
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C

Color 19, 30, 50, 67, 69, 78, 79, 80, 94,
95, 98, 102, 103, 109, 110, 112, 113,
115,117, 118, 120, 121

Color Table Support 95

Command-; 143

Command-. 20

Command-A 125

Command-H 12

Command-O 58, 125

Command-Q 10

Command-R 129

Command-S 15

Command-W 17

Compatible 100, 115, 120, 135, 152

Conic Arcs 67, 107

Contiguous Surfaces 102, 121

Convert To Mesh 112

Corel Draw 61

Create Hermite Surfaces 73

Create Symbols 73

Creating Separate Layers 78

Curve 64, 71, 107, 108, 113, 140
Bézier Curves 52, 64, 65, 99
Composite Curve 106

D

D-Code 54, 57, 135, 136
Dash 43, 45, 97, 99, 100, 107, 111
DDES2/1T8.6 64,97
Default Settings 23, 77
Degree 31, 67

Dialect 141, 142

Die Cutting 66, 97
Dimensions 30, 50, 64, 98
Display Picture 23, 30
Drag 10, 18, 124, 131
Drag & Drop 58, 124
Dreams 64, 82, 98, 141
DWG Files 122

Index 155

D

DXF 16, 17, 25, 27, 29, 30, 35, 37, 38, 43,
51, 64,73, 74,75, 76, 81, 99, 100,
101, 117, 125, 132

DXF Colors 74

DXEF Details 16, 73

DXF Layer Names. 101

DXF Ovals 74

DXEF Text Files 100

DXF Units 25, 73

DXF Version 74, 100
DXFOUT 122

E

Edges 119

Endpoints 61
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